UNIT 1: INFORMATION AND COMMUNICATION TECHNOLOGY FOUNDATION

1.1.  Definition of data

Data: Is raw facts that have entered into a computer but have not been processed.  It refers to statistics, symbols, basic facts, figures, numbers or simply records.

Note: The term data is the plural form of datum. However, in modern usage, the term data is used both as a singular and plural term.

1.1.1. Types of data

Two main types of data in a computer are:

· Analog data: Is that which is in continuous form.

· Digital data: Is data which is in discrete form.

Digital data, unlike analog data, does not vary continuously with time. Digital data are discrete, that is their values have only two possible states: that is, 0 or 1; On or Off; and True or False.

Example of digital data: Is data held or stored in a computer.

1.1.2. Data gathering

This is the systematic collection of data from various sources for a specific purpose.

Method of data gathering

Examples of data collection methods are:
· Observation
· Interviews
· [bookmark: _GoBack]Questionnaires
· Data logging
· Direct data capture
· Studying existing documents
· And use of other technologies

1.2.  Information

Information: Is a processed facts or data that is meaningful and useful to the user.

1.2.1. Factors affecting the quality of information

· Accuracy
· Relevance
· Timeliness / Age
· Completeness
· Presentation

· Accuracy: This is the measure of how close information is to the original data.

· Relevance: Information is considered to be relevant if it can be used for what it was intended. Information that is not accurate or timely is there for not relevant. Relevant information should therefore be appropriate to the user needs.

· Timeliness / Age: Information changes overtime.  This means that out of date information can be irrelevant; therefore, information needs to be up to date to avoid cases of misleading or giving the wrong picture of what is happening.

· Completeness: Good information should be complete. It should provide all the relevant facts and aspects required by the user to make the right decision.

· Presentation: Information should be presented in an organized manner to make it more useful. Presenting information using the best method, possibly by sorting the best method, possibly by sorting or organizing it makes it much easier to understand and to be more useful.

1.3.  Communication

Communication: Is the art or process of coding sounds, words, symbols, signs, pictures, videos or signals in a particular format in order to pass information or message through a medium from one person to another.

1.3.1. Elements of communication

· Source / Sender
· Content
· Communication channel
· Receiver
· Feedback

· Source / Sender: This refers to the communication or originator of the message.

· Content: This refers to the message being communicated.

· Communication channel: This refers to the medium of transmission used to deliver the message.

· Receiver: This is the person who receives the message.

· Feedback: This is the reaction given after the message is received.
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1.3.2. Types / ways of communicating

There are two basic types of communication which include:

· Verbal communication
· Non - verbal communication

· Verbal communication: This is the use of spoken words to send a message. It can also be oral or written. It involves both speaking and listening.

· Non – verbal communication: It includes the use of body language.

1.4. Technology

1.4.1. Types of technology

The types of technology are:

· Technology of teaching
· Assistive technology
· Medical technology
· Information technology (IT)
· Military technology
· Food technology
· Banking technology
· Weather forecasting technology
· Broadcasting technology

1. Technology of teaching 

This is used for teaching.

It includes the following:

· The use of well-defined objectives
· Specific instructional procedures based upon the tasks that learners are required to study.
· Small unity of instruction that are carefully arranged.
· A high degree of teacher activity.
· High levels of student participation
· Careful monitoring of student performance.

2. Assistive technology

It applies various types of services and devices designed to help people with disabilities to function within an environment.

It includes:

· Electronic
· Microprocessor based equipment
· Mechanical
· Non mechanical 
· Specialized instructional materials
· Strategies

Assistive technology enhances the lives of people with disabilities in the following ways:

a. Helps them in learning
b. Improves their quality of life
c. Makes the environment more user friendly
d. Improves their independence
e. Allows them to compete in the workplace

3. Medical technology

It is the use of scientific knowledge in health care to diagnose, monitor and treat diseases or medical conditions.

4. Information Technology (IT)

It is the use of computers, storage devices networking devices, and other electronic devices to create, process, store, secure, and exchange all forms of data.

1.5.  ICT (Information and Communication Technology)

1.5.1. Definition of ICT

ICT: Is an application of information technology and telecommunication that includes the use of computer hardware, software, and telecommunication that includes the use of computer hardware, software, and telecommunications equipment for transmission and presentation of information.

1.5.2. ICT equipment, its use, and interaction

· Radio
· Television
· Mobile phones
· Computers
· Tablet
· Billing Machines
· Satellite
· Projector

1. Radio

This is device that is used to receive radio signals from broadcasting stations and convert them into sound.

Interacting with a radio

To interact with a radio

· Connect the power cable to the power supply or insert dry cells in the radio battery compartment.
· Switch on the power button
· Using the frequency adjustment knob, tune to the desired frequency.

2. Television (TV)

Use of a television

It is an electronic device for receiving and reproducing images and sound of combined video and audio signals.

Interaction with a television

· Connect the television to the source of power.
· Switch on the set top box is on and well configured as directed by the manufacturer
· Tune to the desired channel
· Using the remote control or channel buttons on the TV set, select any other channel of interest.

3. Computer

A computer: Is an electronic device which is capable of receiving data and processing into information.

A computer has the ability to store, retrieve, and process data. The user is able to type documents, send and receive emails, play games, and browse the internet.

Interacting with a computer

· Connect the computer to the source of power
· Switch it on and allow it to boot up
· After the boot up process, the desktop is displayed with icons
· Click on the start button located on the task bar
· From the menu, select the desired program to work with

4. Tablet

It is a portable computer fitted with a touch screen display, circuitry, and battery in a single device. It is also equipped with features, including cameras, a microphone, and a speaker.

5. Billing Machines

Uses of billing machine

It is used in business to itemize, compute customer accounts, generate bills, provide customer invoices, and send account records.

6. Satellite

Use of satellite

A satellite: Is a self-contained communications system. It has the ability to receive signals from the earth and to retransmit those signals back.

7. Projector

It is an output device that uses light and lenses to take images generated by computer and reproduce them on a larger flat screen or wall.

1.6.  Importance of ICT

1.6.1. General use of ICT

· Education
· Health
· Business
· Communication
· Banking
· Manufacturing and production

a. Education

ICT has facilitated education through:
· Computer Aided Learning (CAL)
· Computer Aided Instruction (CAI)
· Computer Assessment (CAA)
· E – learning
· Computer based simulation 

· Computer Aided Learning (CAL)

This is the integration of ICT into the learning process. It is also known as Computer Based Training (CBT). It involves the use of computers in education and training.

Computer Aided Learning (CAL) techniques:

· Education games
· Problem solving tutorials
· Drill and practice
· Simulation

· Educational games: These are electronic games that have content relevant to a subject area

· Problem solving tutorials: These are self-instructional programs that guide the learner through learning and resource material acting as their virtual teacher.

· Drill and practice: A set of question from a database are given to students repeatedly to practice skills and concepts. These questions have the answers in order to help a computer to mark.

· Simulation: Multimedia content is used to mimic real learning activities.

· Computer Aided Instruction (CAI)

This involves the use of computers to teach academic skills to students.  CAI is used to develop communication and language skills.

· Computer Aided Assessment (CAA)

It is a computerized innovation used in marking multiple choice examination papers where a box is marked in pencil to indicate the candidate’s preferred answer.

· E – learning

It is the delivery of educational programs, training or learning materials by electronic means. It uses the electronic devices such as:

· Mobile phones
· Tablets
· Computers
· Internet

· Computer simulation

This is the modelling of a real situation using a computer. It is used to model industrial processes enabling better understanding and improvement of production systems.

In industries, simulation can be used to:

· Train workers such as pilots
· Study the efficiency of a production process
· Evaluate how safe the activities in a factory are.

Simulation is also applied in the learning of mathematics and biological sciences.

b. Health

The following are some of the uses of ICT health care:

· ICT is used in the medical sectors to keep records of patients.
· In the Intensive Care Unit (ICU), ICT is used to control life support machine.
· ICT is used to conduct brain scans, box X-rays, ultra sounds, and other body scans.
· Patients also receive medical diagnosis and advice from foreign medical experts through the use computerized expert systems. 
· Knowledge enrichment, research and education.
· ICT based equipment such as the Magnetic Resonance Imaging (MRU), Tomography scan are used to diagnose complication medical conditions.

c. Business

Business: Refers to commercial activities carried out for profit. Electronic business (e-business) is the application of ICT in support of business activities.

Examples of ICT based business activities include:

· Online shopping
· Advertising and marketing
· Use of electronic billboards
· Promotional presentations

· Online shopping: The use of plastic money, that is, money held in electronic credit cards or mobile devices makes it possible to order for goods and services from the comfort of one’s home or office.

· Advertising and marketing: Through the use of websites, organizations are able to advertise at a low cost. Example: The Online exchange (OLX) website is used for selling second hand items.

· Use of electronic billboards: These are created using graphic software such as 

· Adobe Illustrator
· Adobe Photoshop

· Promotional presentations: These could be created using power point presentations, video presentations, and animation software.

d. Communication

ICT is used to transmit textual, visual and audio information from one point to another through the use of telecommunication equipment at a very high speed.

This is achieved through the use of electronic mails (e-mails), live chatting systems, online meetings (via skype), short messages services (SMS), facsimile (fax), and video conferencing among others.

e. Banking

ICT can be used in banking where transactions such as:

· Electronic Fund Transfer (EFT)
· Internet banking
· Mobile banking
· Use of Automated Money Transfer
· Automated Teller Machine (ATM)
· Database Management 
· Cheque clearing are made possible.

Customer are also enabled to access their bank details through SMS alerts.

f. Manufacturing and production

ICT based systems such as: Computer Integrated Manufacturing (CIM), Computer Aided Design (CAD), Computer Aided Engineering (CAE) are used to monitor and control production processes in factories.

1.6.2. Advantages and disadvantages of ICT

Advantages of ICT

· Use of ICT helps in performing tasks faster and more efficiently.
· ICT enables very high accuracy (not mistakes) levels in large scale production.
· Greater access to ICT technology has helped to bridge the cultural gap by helping people from different cultures to communicate with each other, and allow exchange of ideas and view, hence increasing awareness.
· ICT facilitates efficient sending and accessing of information from different locations across the world.
· ICT tools help organizations to gain a competitive over their competitors.

Disadvantages of ICT

· The initial capital investment of buying new equipment and the cost of maintenance is usually high.
· ICT and automation can lead to loss of jobs, especially for computer illiterate persons.
· ICT equipment such as computes can lead to health problems. Some known health risks related to computer use include eye problems, backache, and wrist injuries.

1.6.3. Current use of ICT in Rwanda

The Rwandan government has invested greatly in a knowledge based economy with ICT as its cornerstone.

· ICT use in education
· ICT use in the health sector
· ICT use in business
· Communication
· Service delivery 

a. ICT use in education

· Learning in schools
· Distance learning
· E-ICT

· Learning in schools: The government project for One Laptop Per Child (OLPC) has facilitated the use of computers in learning institution.

· Distance learning: ICT has facilitated the running of distant educational programs. Distance learning programs offer opportunities for further training for people who desire to advance their education.

· E-ICT: Electronic ICT is easily accessible to anyone interested in high technology courses. Such programs enable one to keep up to date with new technologies.

Example for this: Microsoft office applications and Cisco Networking (International Driving License): Programs used in E-ICT.


b. ICT use in the health sector

· Record keeping
· Mobile e-health systems
· Telemedicine

· Record keeping: The use of systems such as open Medical Records System (Open MRS) and Treatment and Research Aids Centre (TRAC) net system facilitates nationwide tracking of patient data and managing clinical heath information.

· Mobile e-health systems: They are used by community health worker to collect data on patients and health management, for example, Open MRS and TRAC net systems.

· Telemedicine: This facility allows the sharing of clinical information between urban and rural hospitals.

c. ICT use in business

· Mobile banking and financial services
· Village banking
· E-business
· Market survey
· E-Soko

· Mobile banking and financial services: Mobile service provides have introduced money transfer and other financial services.

· Village banking: Banks are using telecommunication facilities to provide banking services in remote areas.

· E-business: ICT is a great medium of transacting businesses. Through electronic payment systems such as credit cards and online banking, clients are able to transact business across borders without moving physically from one location to another.

· Market survey: Rwandans have real time updates about the stock exchange daily market status. This enables them to make informed decisions about investments.

· E-Soko: This project enables farmers to make informed market pricing decisions on their produces.

d. Communication

· Video conferencing
· E-mail
· Internet
· Video conferencing: This refers to communication between individuals in different locations by use of simultaneous two-way audio and video transmissions.

In Rwanda, video conferencing is used in the following situations:

· Holding meeting
· Facilitate distance learning
· Interview employees remotely
· Television and video broadcasting

· Holding meeting: Video conferencing provides a platform to work with others across a distance.

Example: Local government leaders in Rwanda from all districts are able to hold meetings and interact with the minister of local government through video conferencing technology.

· Facilitate distance learning: Student in Rwanda are able to register and take courses offered in foreign universities through online learning.

· Interview employees remotely: Public and private institutions in Rwanda are able conduct job interviews without requiring the interviewees to be physically present within their premises. A popular platform for this is Skype for business.

· Television and video broadcasting: Radio and television reporters are able to relay news on location for broadcasting. Video conferencing also enables a reporter to interview news sources across the world.

· E-mail: E-mail stands for Electronic mail. It is a method of exchanging typed messages and attachments electronically between individuals. It used in Rwanda to communicate with employees, customers, friends, and family. It has enabled people to communicate with others outside Rwanda.

Examples of e-mails software:

· Yahoo! mail
· Gmail
· Hotmail

Some benefits of email

· It allows individuals and group to communicate with one another efficiently.
· It allows for affordable communication since envelopes and stamps are not needed.
· It is convenient since the user does not have to go to the post office to send or receive mails.

· Internet: The following are some of the application areas of the internet:

· Research
· Library
· Online books
· Socializing

· Research: Internet has a lot of information which can be used for research materials.

Example: Sites such as www.kidsclick.org

· Library: The internet has enabled libraries to be accessed from anywhere at any time.

Example: Online library is www.memphislibrary.org

· Online books: Internet has enabled the availability of book online. A book can be accessed easily by many readers.

Example: Online book site is: www.magickeys.com/books

· Socializing: The internet enables the creation of social network services that develop online communications of people who have common interests and activities.

Example: www.fanlla.com and www.facebook.com

e. Service delivery

In Rwanda, the internet has made it possible for delivery of services to the public online. There are services that are delivered through the website known as: www.irembo.gov.rw .

Example of delivered on this website include the issuing of driving licenses and birth certificates.


UNIT 2: COMPUTER SYSTEMS

2.1.1. Definition of a computer 

A computer: Is an electronic device that using a set of instructions, stores it, and gives information as the output.

2.1.2. Functions of computers

Computers perform four major operations or functions namely:

· Input
· Processing
· Storage
· Output
· Input: This is data entered into a computer for processing.

· Processing: This is the conversion of data into information.

· Output: It is the information produced after processing of data is complete.

· Storage: A computer can store a large amount of data within it.

2.1.3. Characteristics of a computer

· Speed
· Accuracy
· Versatility
· Reliability
· Power of remembering
· No Intelligence Quotient (IQ)
· Diligence
· Storage

· Speed: A computer can carry out processing of instructions at a very high speed.

The speed of computer is calculated in Hertz (Hz).

· Accuracy: Computers are very precise in processing data as long as they are fed with correct data and instructions.

· Versatility: A computer can perform more than one task at the same time.  This is called multitasking.

· Reliability: A computer is highly reliable as long as it is fed accurate data reliability.

· Power or remembering: A computer can store and re-produce information any time because of its large secondary storage space.

· No Intelligence Quotient (IQ): A computer possesses no intelligence of its own. If the data fed into the computer does not make sense, the output will also not make sense to the user.

· Diligence: It can also perform long and complex calculations with same speed and accuracy from the start until the end.

· Storage: Depending on the size of its memory, a computer can hold tremendous amount of data.  It also has a variety of removable storage locations that could be used to back up data.

2.2. Computer components

A computer system: Is a collection of components that work together to process data and manage information in a computer in order to achieve a desired goal.

The components that make up a computer system include:

· Hardware
· Software
· Live ware (user)

2.2.1. Hardware

Hardware: Refers to any physical or tangible component of a computer. It could be mechanical or electronic.

Example:

· Central processing unit(CPU)
· Computer peripherals
· Storage media
· Ports
· Connectors

a. The Central Processing Unit (CPU)

CPU: Is also known as the Processor.  It is commonly referred to as the brain of a computer system.

It consists of three components namely:

· Arithmetic and Logic Unit (ALU)
· Control Unit (CU)
· Memory Units (Registers)
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· Arithmetic and Logic unit (ALU)

It is the part of the CPU that performs two main functions, namely:

· Arithmetic operations: Such as addition (+), subtraction (-), division (/), and multiplication (x).
· Logical operations: Such as OR, AND, NOT among others.

· Control Unit (CU)

It is the part of the CPU that coordinates the activities of different section of the processor and input / output (I/O) devices.

It also performs the following activities:

· Controls, supervises, and oversees all activities of the computer.
· Fetches instructions from the main memory (hard drive or RAM).
· Decodes the instructions in a format the computer can understand.
· Executes the instructions by issuing commands to respective components where actions is supposed to be taken.
· determines the text task to be taken up by the processor for execution.
· Processes the data in line with the instructions given.
· Controls the transfer of data and information within the available storage space.

The above functions can be summarized in what is regarded to as Fetch Execute cycle.

· Memory units

The memory units are found in the CPU.

Registers: They are temporary storage locations found inside the processor that are used to hold data, instructions or information awaiting processing or output.

There are four types of registers namely: 

· Instruction register
· Accumulator register
· Address register
· Storage register

· Instruction register: It temporarily holds and instruction before it is converted to machine readable format.

· Address register: It temporarily stores the address of the next instruction to be processed.

· Accumulator register: It temporarily holds the last processing steps of the Arithmetic Logic Unit (ALU)

· Storage register: It temporarily holds information waiting to be output.

b. Computer peripherals

Peripheral devices: Are computer components that are connected to the ports in the system unit through cables or wireless media. They include:

· Input devices 
· Output devices.

Input devices

These are hardware components that are used to enter data and instructions into a computer. They are classified into:

· Keying devices
· Pointing devices
· Scanning devices
· Voice input devices

1. Keying devices

These are input devices that enable entry of data into the computer through the use of a set of keys. These devices are used for typing letters, numbers, symbols, and commands by pressing a key or combination of keys.

Examples:

· Keyboard
· Keypad

a. Keyboard: it is used for typing letters, numbers and special symbols.

It is sometimes referred to the alphanumeric keyboard.

Examples:

· Traditional 
· Flexible
· Braille
· Ergonomic

· Traditional keyboard: They are large and rigid keyboard. They are named based on the arrangement of the first six characters in the first row of the alphabet keys.

They include:

· QWERTY 
· AZERTY
· QWERTZ
· HCESAR

· Ergonomic keyboard: This is designed to minimize wrist injury.  It is connected to the system unit using the Universal Serial Bus (USB) cable. Some ergonomic keyboards are split.

· Flexible keyboard: This is a portable keyboard which can be folded and carried in a bag.

· Braille keyboard: This is specifically designed for the visually impaired. The keys have raised dots enabling the user to feel and identify the character or symbol represented by the key.

· Keypad: This is a small keyboard, which is mostly used on devices such as:

· Palmtops
· Calculator
· Microwaves
· Washing machines

2. Pointing devices

These are devices which control the movement of a cursor or a pointer on the computer screen.

Examples:

· Mouse
· Trackball
· Joystick
· Touch screen
· Light pen
· Touch pad
· Graphic tablet

a. Mouse: There are three types of computer mouse.

· Mechanical mouse
· Optical mouse
· Wireless mouse
· Mechanical mouse: It contains a ball under neath which is rotated when the mouse is moved hence controlling a pointer on the screen.

· Optical mouse: It uses digital image processing technology to track the position of the mouse.

· Wireless mouse: It does not use cables. It uses infrared and radio waves such as Bluetooth to control the pointer on the screen.

Mouse action

· Clicking
· Double clicking
· Right clicking 
· Drag and drop

· Clicking: This is pressing and releasing the left mouse button once. It is used when selection an item.

· Double clicking: This is pressing and releasing the left mouse button twice in quick succession. It is used when opening a file / folder, or starting a program.

· Right clicking: This is pressing and clicking the right mouse once. It is used to display the content menu.

· Drag and drop: It is pressing and left mouse button on an item. The location and the button released in order to move an item.

b. Trackball: It is a pointing device with a ball on the top that is rotated with the finger preferably the thumb, or the palm of the user’s hand to control the pointer on the screen.

c. Joystick: It is a device that looks like a gear lever used to control the movement of the pointer or some objects on the screen.

It is mainly used for playing games. A joystick can contain more than three buttons for further manipulation of the object when playing computer games.

d. Light pen: It is a hand held input device that utilizes a light sensitive detector to select objects or to write on the screen.

It contains sensors at its tip that send signals to the computer whenever light is recorded. They are often used in design and can also be used for sensing information on magnetic bars and stripes.

e. Touch screen: It is an input device designed to recognize the location of a touch on its surface.
f. Touch pad: It is a pointing device commonly found in laptops where the user places or moves the finger across it to control the pointer on the screen.

It contains two buttons that are clicked once the desired location is clicked once the desired location is reached in order to execute an action.

j. graphics tablet or digitizer: It is a pointing device used by designers and artists.  They use it to draw a picture on a computer screen by free hand without using a mouse or a keyboard.

It consists of:

· Flat
· Touch sensitive pad
· Some sort drawing device such as stylus.

Stylus: Is a pen like device moved over the surface of the tablet. Data about the stylus movements are sent to the computer.

3. Scanning devices

They are also known as Scanners. They are peripheral components that capture data from the source directly to the computer by converting it into digital format. The source can either be a paper or an object. 

They are two types of scanner which include:

· Optical scanners
· Magnetic scanners

a. Optical scanners: These scanners capture data using light technology. Light is passed over the object or paper to capture the image. The image is then analyzed by specialized software.

Examples:

· Optical Barcode recognition (OBR)
· Optical Mark Recognition (OMR)
· Optical Character Recognition (OCR)

· Optical Barcode Recognition (OBR)

They are also known as Optical Barcode Readers. 

A Barcode: Is a series of printed parallel vertical lines that differ in thickness and spacing. A barcode contains information about the item ID number.

Once a barcode has been scanned, the computer reads the information stored on the barcode and accessed details about the product from the computer data base.

There are two types of barcode readers:

· Handheld barcode reader
· Countertop barcode reader

· Handheld barcode reader: It is also known as a wand. It is held by hand and passed over the product’s barcodes to read the information.

· Countertop barcode reader: It is permanently fixed on the counter and the product is passed over it to read the information.

· Optical Mark Recognition (OMR)

This is technology is used to read marks made using a pencil on a piece of pre-printed paper.  They are used in reading shaded area in multiple choice examinations, lottery tickets, and questionnaires with objectives type questions.

· Optical Character Recognition (OCR)

Optical character readers consist of a scanner along with special user inter active software.  They allow scanning of characters on paper (Hardcopy) into a softcopy that is stored in the computer. The softcopy version can be edited of formatted.

b. Magnetic scanners: These scanners capture data written using magnetic ink.

Examples:

· Magnetic Ink Character Reader (MICR)
· Magnetic Stripe Reader
· Magnetic Stripe Recognition
· Magnetic Resonance Imaging (MRI)

· Magnetic Ink Character Recognition (MICR): It is a scanner that reads characters printed using special magnetized ink (the ink contains iron particles).

MICR is widely used by bank to authenticate cheques and obtain the information written using magnetic ink on the cheque.

· Mobile card machine: It is also the chip or the pin reader. It is a device used by bank agents to access bank account details of the customer.  A plastic card containing a chip is inserted in a slot. The user then enters his or her Personal Identification Number (PIN).

· Magnetic Stripe Recognition: This reads information coded in a magnetic stripe at the back of a plastic card when the card is swiped through it.

They can also be used to control access to a building by swiping the card through the reader. The difference between Magnetic Stripe Card Reader and Mobile Card Machine is that the magnetic stripe card reader reads cards with a magnetic stripe by swiping; while a mobile card machine reads with a microchip.

· Magnetic Resonance Imaging (MRI): This is a medical imaging or scanning technology that is used to image the human body the body systems. It is used in medical tests. It takes the pictures of human body organs, including tissues and bones. The MRI is used to scan for and diagnose diseases.

4. Voice input devices

These are devices used to input data in the form of spoken words into the computer.

Example:

· Microphone

Output devices

Those are devices used for displaying data and information. They are classified into two categories namely:

· Softcopy output devices
· Hardcopy output devices

Hardcopy output devices

These are devices which produce output that is recorded on tangible media such as paper.

Examples:

· Printers
· Plotters

Printers

A printer: Is a peripheral device that produces hardcopy output. Printers can be broadly classified into:

· Impact printers
· Non-impact printers.

a. Impact printers

They print on paper. The print head physically strikes an inked ribbon.  The ribbon then presses on a paper medium to create the image hence the name impact printer.

Impact printers can produce multiple copies of the same document at the same time using carbonate paper. Due to the impact made by the print head, impact printers are noisy.

Example:

· Daisy wheel
· Dot-matrix
· Drum 

· Daisy wheel printers: These printers got their name from the daisy flower. The wheel has hammer like structures that resemble the petals of a daisy flower. These printers can only print one character at a time.

· Dot Matrix printers: The head of this printer consists of pins arranged in a matrix.

· Drum printers: Characters are raised in a cylindrical drum values of all characters are stored in the printer buffer.

b. Non – impact printers

They are printers that use thermal or electrostatic principles to produce print on paper.  The print head element does not come into contact with the paper; hence they are quiet while printing. They print faster and produce high quality prints compared to impact printers.  

There are three main types of these printers namely:

· ink Jet
· Laser Jet
· Thermal printers

· Ink Jet printers: These printers spray little dots of ink on a paper forming the shapes of characters and pictures when printing. They are commonly used for non-commercial purposes. Their initial cost is low but maintenance cost is very high. This is due to the high price of buying a new cartridge and the low number of print out papers produce per cartridge.

· Laser Jet printers: They use the principle of light to form images on the paper. The printers operate by shinning a laser beam that ionizes some regions on the drum.

· Thermal printers: These printers use thermal (heat) technology to produce images on a special paper. The print mechanism is designed to heat the surface of chemically treated paper referred to as thermochromics or thermal paper.

They are popularly used at Point of Sale (POS) terminals to print receipts.


Plotters

These are special purpose output devices. They are used to produce high quality, multi-color documents or large size documents such as charts, maps, architectural drawings, and three dimensional representations based on commands from a computer.

There are two types of plotters, namely:

· Drum
· Flatted plotters

· Drum plotters: In this type, the paper is mounted on the surface of the drum in the plotter.

· Flatted plotters: in this type, the paper is fixed on a flat surface ad pens are moved to create the image.

Softcopy output devices

These are devices that produce information that can be seen, listened to, but not tangible.

Examples:

· Monitors
· Projectors
· Speakers


Monitors

A monitor: Is also referred to as Video Display Unit (VDU) or the Screen. It is used to display data and information.

There are two main types of monitors:

· Cathode Ray Tube (CRT)
· Flat screens

1. Cathode Ray Tube (CRT) monitors: They are bulky and heavy. They produce an image (made up of tiny dots) by firing electron beams against phosphor screen. Each dot is colored red, green, and blue of different intensities combining to create millions of different color shades.

2. Flat screens: These monitors are becoming popular nowadays and are used in desktop and laptop computers. They are all characterized by the flat shape which makes them to be lighter, less bulky, and they consume less power than the CRT monitors.

Types of flat screen monitors

· Liquid Crystal Display (LCD)
· Thin Film Transitor (TFT)
· Gas plasma Display (GDP)
· Electroluminescent Display (ELD)

· Liquid Crystal Display (LCD) monitor: The monitor consists of two polarizing transparent plates and a liquid crystal solution in between them.

· Thin Film Transitor (TFT) monitor: This is made up of thousands of small pixels. Each pixel consists of three transistors which are red, green, and blue. Each transitor can produce different intensities of light which allow huge amounts of colors to be produced.

A back light: Is used to shine light onto these pixels to enable the colors to be produced.

· Gas Plasma Display (GPD) monitor: It is a thin display screen. It works by enclosing neon gas between two plates where each plate is coated with a conductive print.

· Electroluminescent Display (ELD) monitor: This is an optical and electrical phenomenon where a material emits light in response to an electric current passed through it.

Speakers or voice output devices

These are devices that convert electronic signals from the computer into audible sounds. This is achieved through the use of transducers such as speakers.

A transducer: Is a device that converts energy from one form to another.

Projector

It is a device that uses light and lenses to take am image, magnify it, and project it onto a larges screen or a wall.


Ports and connectors

A port: Is an interface on a computer on which a device can be connected.

A connector: Is a part of a cable that plugs into a port or interface to connect two devices.

Connectors can either be male (containing one or more exposed pins) or female (containing holes into which the male connector can be inserted)

Examples of ports name and their use

	Port name
	Use
	Color code

	PS2 / Mouse
PS2 / Keyboard
	Mouse
Keyboard
	Green
Purple

	Analog Microphone Audio input or stereo
	Microphone
	Pink

	Analog line level audio output side speakers
	Speaker
	Silver

	Power desktop computer
	Desktop computer

	None

	Power laptop
	Laptop

	None

	USB 2.0
	Flash drives / Keyboards
	White


	Parallel port
	Printer
	Burgundy


	Serial port
	Projector
	Turquoise


	Ethernet LAN / NIC /RJ 45
	LAN / Hub / Switch
	None


	MEDEM RJ 11
	Telephone 
	None


	VGA
	Monitor
	Blue


	Display port
	TV
	Black


	HDMI
	Monitors /TV
	B


	HDMI Micro
	Smart phones
	Black





Storage

Storage devices and media

These are devices that are used for storing data, information, and instructions. These are divided into three categories, namely:

· Primary memory
· Secondary memory / Mass storage
· Tertiary storage

a. Primary memory

Primary memory refers to the computer’s memory, which interacts directly with the computer’s CPU. It is also known as main memory. There are two types of main memory, namely:

· Random Access Memory (RAM)
· Read Only Memory (ROM)

Random Access Memory (RAM)

RAM: Is a volatile memory. This means that the contents in it are lost when power is switched off. It holds data temporally before and after processing; and also holds all the programs currently running together with the data being used by the programs.

Read Only Memory (ROM)

ROM: Is a non-volatile memory. This means that the content in it is not loss when power is switched off. The content in ROM can be read but cannot be changed. It is intended for permanent or semi-permanent storage of data necessary for the operation of a computer system.

Types of ROM 

· Programmable Read Only Memory (PROM): Is a Read Only Memory that allows the user to alter it only after the content is written on it.

· Erasable Programmable Read Only Memory (EPROM): Is a Read Only Memory whose content can be erased and can be reprogrammed again.

· Electrically Erased Programmable Read Only Memory (EEPROM): It is a type of ROM that can be erased and programmed again using electricity.

Example: BIOS for storing Basic Input Output system(BIOS)

b. Secondary memory / Mass memory

The computer’s main memory is always limited in terms of permanency and capacity.  The secondary storage devices provide an alternative long term storage of data, information and programs. 

These devices can be classified according to portability, as either:

· Removable storage devices
· Fixed storage devices

1. Removable storage media

They are called removable storage media because they require either a USB port or an external drive connected to the motherboard using a cable.

Examples:

· Magnetic tapes
· CD / DVD disk
· Jaz disk
· Floppy disk

The units for measuring storage capacity is:

· Bytes
· Kilobytes (KB)
· Megabytes (MB)
· Gigabytes (GB)
· Terabytes (TB)

a. CD / DVD disk: They use laser beam of light for reading and writing data.

· Compact Disk (CD)
· Video Compact Disk (VDC)
· Digital Versatile Disk (DVD)

· Compact Disk (CD): This is a hard plastic disk on which information such as music or computer data is stored. The storage capacity of a CD ranges between 650 MB and 700 MB.

They are available in three forms:

· Compact Disk Read Only Memory (CD-ROM)
· Compact Disk Recordable (CD-R)
· Compact Disk Read / write (CD-Rw)

· Compact Disk Read Only Memory (CD-ROM): Data can only be read from it but cannot be written to it. They are popularly used to package and distribute software and music among other types of data.

· Compact Disk Recordable (CD-R): Once data has been burned on it, it cannot be erased but more data can be added on the empty tracks.

· Compact Disk Read / write (CD-Rw): These compact disks allow the user to record, erase, and rewrite new information as many times as desired.

· Video Compact Disk (VCD): It is a compact disk that is able to read and view graphics, data, audio, and video at the same time.

· Digital Versatile Disk (DVD): They are also known as Digital Video Disks. They are optical media used for storing digital data. They resemble CDs but have a higher capacity than the CD.

Examples:

· DVD-ROM
· DVD-R
· DVD-RW
· Blu-Ray
· USB Flash memory
· Memory cards

· Digital Versatile Disk – Read Only Memory (DVD-ROM): In this media once data has been written, it cannot be erased or modified. It can only be read.

· Digital Versatile Disk-recordable (DVD-R): Once data has been burned on it, it cannot be erased. It becomes Read Only.

· Digital Versatile Disk Rewritable (DVD-RW): They allow the user to record, erase, amend, and rewrite new information.

· Blu-Ray: It is a high definition DVD format that is intended to replace the current range of DVDs. It is used for distributing large amount of material such as movies.

· USB Flash memory: They are also known as the memory stick (Men stick). Their capacity ranges between 1 GB and 16 GB.

· Memory cards: They are used in digital cameras and mobile phones for storing or transferring data from a device to another.  They are inserted in a special slot for data reading and writing. Their capacity ranges between 1 GB and 16 GB.

2. Fixed storage media

They are known as fixed storage media because they are mounted media because they are mounted on the computer motherboard. They are housed inside the computer unit.
An example: - Hard disk

Hard disk: It consists of one or several inflexible circular disks called platters which are coated with a magnetic material normally Iron II Oxide.

c. Tertiary storage

The main purpose of tertiary computer storage is to store data on a very large scale.

2.2.2. Software

Software: Is abbreviated as SW or S/W. it refers to a set of instructions that either enable the computer hardware to perform its assigned tasks or help the user to accomplish specific tasks.

Software is also referred to as Programs.

Classification of computer software

Computer software can be categorized in two different classes, namely:

· System software
· Application software

1. System software

System software: They are software designed to many age computer resources and provide these resources to the user.

They are five types of system software namely:

· Operating system
· Utility software
· Firmware
· Programming languages
· Networking software

a. Operating system (OS)

Operating system: Is a group of programs that provide a platform for loading other programs known as application programs. The OS acts as an interface between the hardware and the application programs.

Examples:

· Linux
· Ms DOS
· Ms Windows
· OSX
· iOS
· Android
· UNIX

b. Utility software

Utility software: They are system software that are used to perform routine functions aimed at optimizing, analyzing, and maintaining the operations of a computer.

They manage computer files, diagnose, repair computer problems and help the computer to run more efficiently.

Examples:

· Antivirus
· Disk cleaners
· Disk checkers
· Disk compressors
· Disk defragmenter
· Disk partitions
· File managers
· Language translators
· Graphic editors
· Text editors

c. Firmware

Firmware: They are sometimes referred to as stored logic. Those software programs that are stored in the computer’s Read Only Memory (ROM), where they are available for immediate use.

They are not affected by loss of power hence the term firm.

Example:

· Basic Input Output System (BIOS)


d. Programming language software

These are formal constructed languages designed to communicate instructions to a computer. They are used to create programs of a machine. They have language translators integrated in them.


2. Application software
Application software: They are programs that are designed to enable the user to accomplish a given task. 

They are two groups of applications software, namely:

· Customized software
· Off the shelf software

a. Customized software: They are also known as in house developed software. They are tailor made to solve a specific problem at hand, or to meet a specific need of the user. They only contain features that are required by the user.

b. Off the shelf software: They are also known as standard software. They are software written by a software engineer or a programmer, packaged, and then made available through a vendor, a distributor, or a developer.

Examples:

· Microsoft word
· Open office writer
· Ms Access

2.3.  Computer family

Computer family: Refers to category of computers with the same operational design and microprocessors that are compatible with each other.

Examples:

· IBM
· PC Versus
· Mac family

Computers in these families can be classified as:

· Microcomputers
· Minicomputers
· Mainframe
· Supercomputers

1. Microcomputers

Microcomputers: Are popularly known as personal computers (PCs). They are designed to be used by one person at a time. They are the smallest, cheapest, and most portable. They are commonly used in offices, for training, entertainment, communication, business enterprises, and in homes among other places.
Examples:

· Desktops
· Laptops
· Tablets
· Personal Digital Assistants (PADs) or Palmtops

· Desktop computers: These are computer designed to be used while placed on top of a desk or a table.

· Laptops: These are portable computers. They have all Input / Output processing and memory devices inside the system unit.

· Tablets: These are small, portable computing devices, similar to a notebook. They are used for internet access.

Note: The main differences between a notebook and a laptop are:

· A laptop has more ports and other plug in options to allow for connection of additional peripherals compared to a notebook.

· A laptop has both the USB port and an inbuilt Digital Versatile /Compact Disk drive where as a note book only contains the USB port. 

· Palmtops: They are also referred to as handheld computers, or PDAs. They are designed to fit in the palm of the hand and easily fit in a pocket. They are commonly used in communication.

2. Minicomputers

They are also referred to as mid-range computers. They are small in size and cheaper. They have a low processing speed compared to super and mainframe computers. Their storage capacity is higher than that of microcomputers.

3. Mainframe computers

They are the second largest in physical size. They are very large and expensive they are capable of supporting thousands of users in a computer network simultaneously.  Mainframes are used for centralized.

Examples:

· In large commercial organizations
· Government agencies
· Banks
· Hospitals
· Airlines
· Manufacturing companies
· Telecommunication agencies

4. Supercomputers

They are the largest in size, faster, most powerful and most expensive computers. They are used to process large amounts of data at very high speed and they solve problems requiring complex calculations within a fraction of a second.

These computers are mainly applied in scientific research work.

Examples:

· In weather forecasting 
· Advanced military application
· Telecommunication companies

2.4.  History (Evolution) of computers

The evolution of a computer has taken many years and it exists out of inventions by different scientists. 

The following tools have been invented over time leading to the development of current computers:

· Abacus
· Pascaline / Machanical calculator
· Analytical engine and Difference Engine

a. Abacus: It was the earliest counting tool used by Baby lonians in around 300 BC. They later became associated with Chinese more than 2000 years ago.

b. Pascaline / Machanical calculator: The French mathematician, Blaise Pascal invented the first mechanical calculator or calculating machine in 1642.  It could add and subtract numbers, hence helped his father who was a tax collector.

c. Analytical Engine and Difference Engine: Charles Babbage was an English mathematician, a philosopher, engineer. He initiated the concept of a programmable computer. While Babbage’s machines were mechanical and cumbersome, their basic architecture was similar to a modern computer.

He invented a Difference Engine followed by an Analytical Engine.

· Difference Engine: This was an automatic mechanical calculating machine. It could perform mathematical calculations commanded by a fixed instruction program. It was invented around 1822.

· Analytical Engine: This machine was a general purposefully program controlled, automatic mechanical and digital computer. As a result of his invention, Charles Babbge day computers. It was invented around 1832.

The main difference between the Difference Engine and the Analytical Engine could be programmed using punched cards. In the 1840’s a mathematician known as Ada Lovelace developed a program for the Analytical Engine. 

Based on her work, Lovelace is recognized as the first computer programmer.

2.5. Generations of computers

2.5.1. First generation computer (1940’s to mid-1950’s)

Characteristics of the first generation computers:

· They used vacuum tubes or thermionic values technology for amplification and as switching devices.

· These computers used the machine language for programming.

· They used magnetic drums for internal memory.

· Punched cards were used for data input.

· The output was given in form of print outs.

Examples of computers in the first generation:

· Electronic Discrete Variable Automatic Computer(EDVAC)
· Universal Automatic computer (UNIVAC)
· Electronic Numerical Integrator and calculator (ENIAC)
· Mark 1

Disadvantages of the first generation

· The vacuum tubes were huge. They, therefore, made the computers heavy and bulky.
· They consumed a lot of electrical power.
· They generated a lot of heat. This resulted in frequent breakdowns.

2.5.2. Second generation computers (mid-1950’s to early 1960’s)
Characteristics of the second generation computer

· They used Integrated Circuits (IC’S) technology.
· Magnetic disks and magnetic tapes were used for secondary memory.
· Keyboards were used for data input.
· Monitors were used for data output.
· Common Business Oriented Language (COBOL) and Formula Translator (FOTRAN) programming languages were used for programming.

Examples of computers in this generation

· Burroughs B 6500
· Honeywell 115
· IBM 360

Advantages of second generation computers

· They were smaller and less expensive than the previous two generations.
· They had a higher processing speed and storage capacity compared to the previous generations.
· They consumed lesser electrical power compared to the previous generation.

Disadvantage of second generation computers

· The initial cost was high due to the sophisticated technology required in the development of Integrated circuits (IC).
· Air conditioning was required since they still produced a lot of heat.

2.5.3. Third generation computers (early 1970’s o late 1980’s)

Characteristics of the third generation computes:

· They used Large Scale Integration (LSI) and very Large Scale Integrated (VLSI) circuits technology commonly known as Microprocessor.
· Optical disks, magnetic disks, and magnetic tapes were used as secondary memory.
· Virtual memory was introduced. Virtual memory refers to the use of part of the hard disk as main memory for storing tasks held in the processor.

Examples of computers in this generation

· IBM 370
· Macintosh
· Apple II
· Honeywell DPS 88

Advantages of the third generation computers
· They are smaller because of high level of circuit integration; hence they are portable.
· They are cheaper since they are readily available in market.
· They have very high processing speeds compared to the previous generations.

2.5.4. The fourth generation computers (Early 1990’s to present)

Characteristics of the fourth generation computers

· They use parallel architecture and super conductor technology.
· They use Artificial Intelligence (AI). This is the science of developing machines that mimic human behavior such as reasoning, learning, hearing, seeing, and communicating.

2.6.  Advantages and disadvantages of computers

2.6.1. Advantages of a computer

A computer:

a. Performs tasks faster and more efficiently than a human being.

b. Processes the work accurately when correct data is fed into it.

c. Performs a variety of tasks at the same time and helps the user to solve different problems while at the same time offering entertainment. A user, for example, play background music while working on other tasks.

d. Reduces costs: In an automated office environment, a computer is used to perform tasks that would normally be assigned to several officers.

e. Offers convenient and paperless storage.

f. Is automatically programmed to receive instructions.

2.6.2. Disadvantages of a computer

· A computer cannot reason.

· Using computers can lead to some health problems, especially if not properly used.

· Computers are expensive to acquire.

· Computers and automation can lead to loss of jobs, especially for computer illiterate persons.



2.7.  Areas where computers are used

The use of computer technology has reduced the world to be one small village, also known as the global village. 

A computer can be used in the following areas:

· Communication industry
· Media sector
· Business industry
· Education sector
· Entertainment industry
· Medical field
· Security system
· Traffic control
· Weather control
· Office works
· Storage
· Manufacturing sector

2.7.1. Use of computers in the communication industry

The computer has opened up communication channels.

Examples:

· Through a computer that is connected to the internet, one is able to use electronic mail (e-mail).
· Computers technology has enabled the generation of digital content leading to high quality signals for television and radio transmission.
· Computer technology has also enabled communication possible through social media platforms such as WhatsApp! And Twitter.

2.7.2. Use of computer in the media sector

· Advertisement companies use computers to design advertisement bill board and place them on the streets and at bus stations.
· Digital cameras are used to capture high quality images and pictures which are used in bill boards, print media, and broadcasting.
· Television broadcasting has been changed from analog to digital systems.
· Video conferencing facilities have enabled media personnel to broadcast information from two different countries or locations at the same time.
· Smart boards and tablets are used in news or events reporting.

2.7.3. Use of computers in the business industry

· It is possible to buy goods and services from anywhere on the globe through electronic commerce (e-commerce). This involves selling and buying of goods and services through the internet.
· For businesses that have embraced technology, they have improved their levels of customer service.
· Computers allow businesses to create websites, advertise their products, and connect with other businesses by uploading their latest articles, product images, and blog posts.
· Accounting software allows business to input financial data and analyze it to establish their gains and losses.
· Businesses store data centrally for easy access from multiple computers or stored locally for individual use.

2.7.4. Use of computers in the education sector

The education sector has improved a great deal due to the integration of computers. In this sector, computers are used as an aid in teaching and learning activities. Students are able to register for courses offered outside their country without having to travel abroad.

This referred to as Online learning, and it is done through the internet. Information technology has also facilitated education through:

· Computer Aided Learning (CAL)
· Computer Based Simulation (CBS)

· Computer Aided Learning (CAL)

It is also known as computer Based Training (CBT). This refers to integration of ICT into the learning process. It involves the use of computers in education and training.

Computer Aided Learning (CAL) techniques

· Education games
· Problem solving tutorials
· Drill and practice

a. Education games: These are electronic games that have content relevant to a subject area.

b. Problem solving tutorials: These are self-instructional programs that guide the learner through the resource material acting as their virtual teacher.

c. Drill and practice: A set of questions from a database are given to students repeatedly to practice skills and concepts.

· Computer Based Simulation (CBS)

Computer simulation is the modelling of a real life situation using a computer. It can be used to mimic a real learning situation.

2.7.5. Use of computers in the entertainment industry

· Desktop computers and portable computers are used for playing games. These games can be downloaded from the internet or they can be bought from vendors.
· Disk Jockeys (DJs) use computerized systems to mix and play music in social events such as weddings and parties.
· Computers have made it possible for artists to produce their content and store it in digital format. They are also able to sell it online.

2.7.6. Use of computers in the medical field

· Computers are used in the medical sector to keep records of patients.in the Intensive Care Unit (ICU), computers are used to control life support machines.
· Machines such as Magnetic Resonance Imaging (MRI) scanners are used to generate images of a human body during medical diagnosis.
· Patients also receive medical diagnosis and advice from medical experts through the use of computerized expert systems.
· Doctors can be reached easily through the use of cell phones and electronic mail (e-mail).
· There are many mobile applications that are used in the medical field.

2.7.7. Use of computers in security systems

· Computers are used by the law enforces to analyze finger prints.
· Security forces also use computer based face recognition programs and crime scenes analysis to carry out their investigations.
· Computer based systems are also being used in tracking down vehicles.
· Closed Circuit Television (CCTV) systems are used in buildings, homes, streets and shopping malls to monitor the ongoing activities.
· Computerized metal detector machines are also used to ensure that people and cargo, for example, harmful explosives are not delivered into buildings or restricted environments.

2.7.8. Use of computers in traffic control

Computerized systems can be used to control traffic on roads, oceans and air.

· Air traffic control
· Ship traffic control
· Automobile traffic control

a. Air traffic control: Every airport has its own air traffic control staff that use computer systems to monitor every signal flight.

b. Ship traffic control: ICT helps with working out the logistics of shipping by providing a means of monitoring ships efficiently.

c. Automobile traffic control: Computerized systems are used for controlling and coordinating traffic lights.

2.7.9. Use of computers in weather control

Weather forecasting sensors and instruments collect the data, then send it to computers for storage and analysis.

The following are some of the systems used in weather forecasting:

· Doppler radar
· Weather balloon
· Satellites

· Doppler radar: This is device that uses beams to detect the location of storms, indicate wind direction and speed of wind, and the amount of rainfall, among other weather conditions.

· Weather balloon: It is s special type of high altitude balloon filled with hydrogen or helium. It is fitted with a device called a radiosonde that records weather conditions.

· Satellites: They are used to take pictures that help in the creation of weather maps that show type of coulds and the amount of rainfall.

Example: METEOSAT

2.7.10. Use of computers in office work

· Computers are used in offices to prepare memos, letters, and reports, among others. They can be used for preparing daily programs for the staff.
· They are also used for the purposes of keeping track of the computing activities carried out by employees.

2.7.11. Use of computers for storage

Computers with large storage space are used for storing volumes of files that could otherwise occupy a lot of floor space.

2.7.12. Use of computers in the manufacturing sector

Manufacturers use computerized machines called robots to do jobs that may pose danger to human beings.  Robots also help to reduce human labor costs.

Computers are also used for quality and process control in some companies such as chemical industries. Other industries also use computers for inventory control, as well as preparing and processing cheques.


UNITI 3: COMPUTER NAVIGATION

3.1. Desktop

3.1.1. Definitions

· Desktop: Is the first screen that is displayed when a computer boots up.

To boot a computer: Is to start it so that it can load the operating system and make it ready for use. The desktop consists of:

· Icons
· Task bar, …

· Desktop icons: Icons are images that represent application programs, folders, and files.

Icons on the desktop includes:

· Computers
· Documents
· Recycle bine, …

· File: Is a collection of data that are stored together.

· Folder: Is a specific storage location in a storage media. Folders are used to organize and store related files.  

A folder may also contain other folder within it which are called Subfolders.

· Task bar: It is a bar usually at the bottom of a computer screen showing running programs.

· Start button: It is the button in the far left bottom corner of taskbar.

· Task manager: It is used to provide information about the programs that are running on a computer, as well as the general status of the computer.

· System tray / Notification area: This is of the taskbar in the desktop interface that displays small icons on the opposite side of the start menu such as the clock, date and time, antivirus, and the icons of certain programs so that a user is reminded that they are running in the background.

· Quick launch: It is a part of the taskbar near the start menu where shortcuts to programs are added.

Customizing the desktop

Customizing: Refers to personalizing the desktop to suit the user’s needs and takes.

The changes that the user can make to customize include:

· New themes
· Mouse pointers
· User images
· Gadgets

· To customize, right click on the desktop
· Click Personalize
· Select the desired option from the left pane of the Personalization window.
· Click on the desired option on the right pane.

Customizing the taskbar

· Right click the task bar
· Click on the Properties option
· A dialog box appears. Click on the desired option from the window.
· Click Apply button.
· Then Ok to apply and close the dialog box.

Task bar customization options

· Lock the taskbar
· Auto hide the taskbar
· Use small icons
· Taskbar location screen
· Taskbar buttons
· Notification area

a. Lock the task bar: Check marking this option ensures that the taskbar cannot be moved or changed in size.

b. Auto hide the taskbar: Check marking this option hides the taskbar until the mouse pointer moves over the area where it is hidden and it pops up.

c. Use small icons: This changes the size of the icons on the taskbar and the width of the taskbar. 

d. Taskbar location on screen: It helps position the taskbar at the left, top or right of the screen instead of the default location at the bottom.

e. Taskbar buttons: Helps select how application icons behave, that is, always combine, hide labels, combine when taskbar is full, and never combine.

f. Notification area: It is used to select icons and notifications that appear on the taskbar.

3.1.2. Explore and customize the start menu

Ehen the start button is clicked; two panes are displayed. The left pane shows the most used programs. The right pane shows icons of programs pinned to the start menu.

The start menu can be customized as follows:

i. If a program is not among the most used, click on All Apps. Right click the program name then select pin to start.
ii. To remove a program pinned on the start menu, right click on it then select unpin from start.

To add a program icon to the taskbar 

· Right click the program icon then select More button.
· Select Pin to taskbar option. The program will be automatically added to the start menu.
· To control the items displayed on the start menu, do the following:

· Click the start menu, select All Apps then click on setting. The setting dialog box appears.
· Click on personalization
· Click on start

3.1.3. Recycle bin
 
Recycle bin: It is a container that temporally stores deleted files and folders before they are permanently deleted. It allows restoring of files and folders that have been deleted accidentally.

Role of the recycle bin

· Deleting files and folders
· Restoring files from the recycle bin

1. Deleting: Is to move files or folders to the recycle bin. To delete a file permanently; you go to the recycle bin and delete it again.

2. Restoring: Is the act to rescuing and retrieving the deleted files and folders from the recycle bin.
Warning: Once items have been deleted from the recycle bin, they cannot be restored. Always keep a backup of your work.

3.2. The control panel

It is a graphical user interface found on the start menu which allows users to view and manipulate basic system settings and controls.

3.2.1. Desktop background and theme, window color and screen saver 

Desktop background and theme

A background also known as wall paper. It is an image used to decorate the graphical user interface on the screen.

A theme: Is a preset package used to customize the look and feel of graphical appearance details. 

It replaces a computer’s ordinary icons, sounds, pointers, background, or screen pattern to reflect the interests of the user.

To customize the desktop background and theme

i. Click the start menu, select All Apps then click on setting.
ii. Click on personalization
iii. To change the background, click on background.
iv. To change theme, click on themes in the left pane then click theme settings in the right pane.
v. Click on the desired background.
vi. Click save theme. Type the name of the theme then click save.

3.2.2. Mouse pointer

To customize the mouse pointer

i. Click start button, select All Apps then clicks setting.
ii. Select themes in the left pane.
iii. Click on mouse pointer settings hyperlink in the related settings section.
iv. Click pointers tab
v. Select the desired pointer option under customize.
vi. Click Apply the Ok.

3.2.3. Desktop icons and gadgets
Icons: Icons are small images used to represent a program, file, folder or commands. 

To customize desktop icons

· Click start button, select All Apps then click setting and select personalization.
· Select themes in the left pane
· Click on desktop icon settings hyperlink in the related settings section.
· Select the icons to appear on the desktop, for example, computer, network and control panel.
· To change the way an icon appears click on change icon button, select a desired option from the window displayed and click the Ok button.
· Click on restore default button the setting to the original factory settings.
· Click Apply then Ok to close the window. 

Gadgets: Is a small application that is designed to sit on a user’s desktop screen and is capable of performing different tasks.

Examples:

· Clock
· CPU meter
· Calendar, …  

To show gadgets on the desktop

· Point to view, and then click show desktop gadgets.

You can keep gadgets on top of your open windows so they are always visible. To do this, right click gadget, and then click Always on top.

If you do not want a gadget to appear on top of your open windows, right click the gadget, and then click Always on top to clear the check mark.

3.2.4. Screen resolution

Screen resolution: It determines the clarity of the text and images displayed on the screen.

To change screen resolution

· Click start button, select All Apps then click setting and select system.
· Select Advanced display settings link in the right pane.
· Click on the box below resolution. Select the preferred resolution using the slide.

3.2.5. Changing Date and Time

i. Click start button, select All Apps then click setting and select Time & Language.
ii. Click on Date & Time link in the left pane.
iii. Click on Change Date and Time formats. Select the preferred date and time on the respective list boxes then click on the Back button.
iv. Click change button then select new date and time format on the list boxes displayed. Click change to apply.

3.2.6. Keyboard layout

This refers to the arrangement of keys.

To change keyboard layout

· Click the start button and select setting 
· Select Time & Language, click on Region &Language on the left pane desired and click set as default.

3.3. Windows

3.3.1. Definition

A window: Is an open application on a computer’s display screen. A window shows the program currently running.

3.3.2. Types of windows

There are two types of windows, namely:

· Application window
· Document window

1. Application window: It is the larger window that is displayed when an application is opened.

Examples: 

· Ms Word
· Ms Excel

It helps the user to communicate with the application program.

2. Document window: It is the smaller window inside the application window. It is used for typing, editing, drawing and formatting the text and graphics.

3.3.3. Window control buttons

There are four window control buttons, namely:

· Minimize
· Restore down
· Maximize
· Close

· Minimize: It removes a window from a view to an icon the taskbar.

· Restore down: It reduces the size of a window.

· Maximize: It enlarges the window to occupy the entire screen.

· Close: It exits the active program.

3.3.4. Common windows Accessories

The common windows accessories:

· File explorer
· Math input panel
· Windows journal
· Paint

· File explorer: it is also known as Windows Explorer. It refers to the graphical file management utility that displays the drives and contents of folders ad files in the computer.

· Math input panel: It is a program whose purpose is to use input devices such as touch screens, external digitizers or even a mouse, to write mathematical formulas which are recognized and inserted into different types of documents.

· Windows journal: it is an application program that enables the user to make use of tablet pen to take hand written notes on a tablet PC.

· Paint: It is an application program designed for drawing images on the screen using a pointing device.
3.3.4. Files and folders

File: It is a group of related data given a unique name for ease of access, manipulation and storage.

Creating a file

i. To create a new file, click the File menu in the active program and click New.
ii. On the right pane, click create button and select Blank document under the available templates to create a new file.

Folder: It is a specific storage location in a storage media. Folders are used to organize and store related files. A folder may also contain other folders within it which are called Subfolders.

Creating a folder

a. Using the menu

· Double click This PC icon on the desktop 
· Select the folder / drive where the folder was to be stored.  For example: Documents
· Click on the Home tab in the meu bar select the New folder command in the new group.
· A folder will be automatically created with a default name New folder highlighted and surrounded with a box. Type a name for the folder and press Enter.

b. Using right click

· Double click This PC icon on the desktop
· Select the folder / drive where the folder was to be stored. For example: Documents.
· Right click on an empty space
· Select New from the drop down menu that appears then click on Folder.
· Type the desired name to replace the name New folder then press Enter.

Saving 

Saving: It is a process of storing a document in a storage medium or device for future reference or later use.

There are two ways of saving a document:

· Save
· Save as

· Save: It updates an active or existing document in a given location.
· Save as: It allows one to enter a new file name and specify the location where to store the document.

To save a file for the first time 

· Click on File tab and select Save as command.
· Select the location to save the file from the left pane. For example: Documents or This PC.
· Type the file name in the File name box.
· Click the save button

Opening a file

· Double click on the file
Or
· Right click and then click Open from the pop up

Renaming a folder

Renaming: Refers to changing the name of a file or a folder.

To rename a folder

· Double click This PC icon on the desktop 
· Select the folder / drive where the folder was initially stored. For example: Desktop
· Click on the folder to be renamed.
· Click on the Home tab in the menu bar, select the Rename command in the Organize group.
· Type the new name and press the Enter key.

Rename a file

· Right click on the file to be renamed
· Select and click Rename option from the popup menu.
· Type the new name over the old name then press the Enter key.

Cutting and pasting folders

Cutting: It also known as moving. It is the transfer of the selected file or folder to a new location without leaving a copy at the source location.

The operating system automatically stores the cut data in a clipboard from where it will be pasted to the new location.
Pasting: Refers to placing cut file or folder to a new location.

a. Using the menu

To move the selected file (s) or folder (s) to another location using menu:

· Double click This PC icon on the desktop
· Select the folder / drive where the folder was initially stored, for example: Desktop
· Click on the folder to be moved
· Click on the Home tab in the menu bar, select the Move to command in the organize group.

b. Using keyboard

To move selected file (s) or folder (s) using the keyboard commands:

· To cut: Select the folder to be moved. Press CTRL + X.
· To paste: Click on the new location for the folder. Press CTRL+ V.

Cutting and pasting files

a. Using right click

· Select file to be cut
· Right click on the file then select Cut option from the pop up menu.
· Right click on the new location where the file is to be pasted then select Paste option.

b. Using the menu

To move the selected file (s) to another location using menus:

· Double click This PC icon on the desktop
· Select the folder / drive where the folder was initially stored, for example: Desktop
· Click on the file to be moved.
· Click on the Home tab in the menu bar, select the Copy command in the clipboard group.
· Click on the new location and select Paste command in the clipboard.

Deleting files or folders

To delete a file or folder:

· Click on the file or folder to be deleted. Press Delete.
· Right click on the folder to be deleted and then select Delete option from the popup menu.
· Click Yes to confirm deletion and No to cancel.


UNIT 4: SAFE, SECURE AND ETHICAL USE OF COMPUTERS

By the end of this unit, you should be able to maintain a computer in good working condition and use it safely, securely and ethically.

4.1.  Safe lab procedure

A computer laboratory: Simply known as a computer lab. It is a special room set aside for safe storage and use of computer equipment.

4.1.1. Safety precautions and practices in a computer laboratory

Computers are expensive to acquire. They are also delicate and must, therefore, be handled with great care. Some safety precautions and practices are discussed below:

General safety

The general safety precautions and practices:

· Do not run in and out of the computer lab. This may cause one to knock down computer equipment hence causing damage.

· Always cover the computers with dust covers after use to avoid dust accumulation on the machined.

· Do not carry food or drinks to the computer lab.

· Reinforce the entrance to the computer lab by use of padlocks, burglar proof doors, and metallic grills to ensure proper security of computer resources.

· Ensure that the computer lab is well ventilated to ensure the right amount of temperature and humidity.

· Always shut down the computer using the correct procedure. This is because improper shutting down of computer can lead to either data loss or crashing of the hard disk.

The correct procedure for shutting down a computer

· Close all open files and folders 
· Select the start button and select shut down.
· The shutdown procedure automatically starts.
· Switch off the monitor
· Always consult the teacher or the technician before performing technical operations.
· Ensure that all the cables in the computer laboratory are laid along the walls.

Health safety

Health safety precautions

· The screen resolution should be properly adjusted and where necessary use anti gale screens to prevent eye strain.
· Use ergonomics chairs, tables, keyboards and mice among others to ensure good.
· Ensure there is proper ventilation in the computer lab to ensure good health of the user.
· Always take a break to prevent fatigue or repetitive strain injury.

Electrical safety

Electrical safety precautions 

· Be careful when handling power cables and Cathode Ray Tube (CRT) monitors
· Do not attempt to repair power supplies or CRT monitors.
· Always connect computers using uninterruptible power supply (UPS). This protects them against damage by power instability.
· Ensure cables are insulated to avoid short circuits or electrical shock.

Fire safety

Fire safety precautions

· Ensure that the computer lab is equipped with fire extinguishers that are regularly serviced.

A fire extinguisher: Is a device that used to put out fire.

· Ensure that the computer lab has an exit door for use in case of emergency or file outbreak. 
· Ensure that the computer lab has fire or smoke detectors and alarms for warning in case of fire outbreak.
· Do not smoke in the computer laboratory.

4.2.  Proper use of cleaning tools and fire extinguishers
Cleaning cloth: A lint free cloth is used to clean components such as the case drives, mouse and keyboard because they do no leave residue and will no scratch plastic surfaces.

Do not use a cloth to clean any circuitry such as the motherboard and RAM.

Brushes and swabs: Soft bristled brushes and swabs that are lint free are used to dust off the hard to reach areas and to wipe strains from electrical contacts.

Blower: It is a portable electric device used to remove dust and dirt from computers.

Portable vacuum cleaner: It is a device used for sucking dust, dirt, hair, and other particles when cleaning other computer lab floor and other surfaces as well.

Non static vacuum cleaner: This is a small hand held vacuum cleaner that is designed specifically for use on computers to suck up dirt and dust loosened by brush or canned air.

Canned air: Is also known as gas duster or compressed air. It is used to loosen dirt and dust form delicate computer components.

Somme safety precautions when using canned air

· Do not shake the container because it can explode
· Always keep the liquid canned air upright
· Avoid inhaling canned air because it can lead to death.

Fire extinguisher

It is a metallic cylinder usually red in color. It contains a substance that puts out a small fire. The computer laboratory must be fitted with gaseous fire extinguishers filled with carbon (IV) oxide to be used in case of fire outbreak.

To use a fire extinguisher:

· Pull the pin. This will allow one to discharge the extinguisher.
· Aim (point) at base of the fire.
· Squeeze the top handle or lever to release the pressurized extinguishing agent in the extinguisher.
· Sweep from side until the fire is completely extinguished.

4.3.  Maintaining your computer

a. General precautions

· Computers should be connected to the UPS or plugged into a quality surge protector.

· Ensure the antivirus software is updated regularly.

· Always shut down the computer using the correct procedure.

· Avoid placing computers and related components at the edge of the table where they are likely to fall.

· Laptops should be carried in a bag with padding for protection.

· Engage the services of a reputable insurance company to cover the risk in case of loss or damage.

b. Power connectivity

· Ensure there are enough sockets in the computer lab to prevent overloading.
· Connect the power cable from the main power source to the UPS and to the power supply unit on the computers.
· Correctly turn off the computer when not in use. Always remember to switch off the main power source.
· Install a stand by generator that can automatically be used in case of power failure.

c. Precautions for connecting the mouse, keyboard and other external peripherals

· Connect the peripheral devices to the correct ports.
· Do not force peripheral devices into the ports to avoid bending the pins as this can lead to malfunctioning.
· Ensure that monitors are correctly connected.

Maintenance precautions

a. System unit 

· Switch off the computer system and unplug the power cable before removing the system unit cover.
· Use a damp lint free cloth to clean the outer part of the system unit.
· Avoid using water to clean the internal components to prevent rusting.

b. Monitor

· Never spray cleaners directly onto the screen.
· Clean the outside of the monitor with a recommended cleaning solutions.
· Avoid pressing too hard on the screen when cleaning an LCD screen.
· Avoid cleaning the inside of the monitor.

c. Keyboard

· Do not punch down keys with excessive force since this may damage the components under neath.
· Be careful to avoid dripping cleaning liquids on to or into the keyboard.
· Do not remove the keys but instead use canned air and a soft bristles brush to clean hard to reach areas.

d. Mouse

Use a damp lint free cloth to clean the external part of the mouse.


UNIT 5: WORD PROCESSING BASICS I

5.1. Word processing

Word processors were created to solve the problems encountered while using a typewriter.

5.1.1. Definition of word processing application

Word processing application: Is a software that enables the user to create, save, edit, format, and print text documents.

Examples:

· Word perfect
· Word star
· Lotus word Pro
· Ami Pro
· Microsoft word, …

5.1.2. Role of word processing application

· Crete and manipulate text based and objects.
· Create a document to be uploaded to the internet.

5.1.3. Starting word processing applications (Ms Word)

· Click on Star button, go to All programs, select Microsoft office, then click on Microsoft word 2013.

Or 

· If the Ms word icon is on the desktop, do one of the following:

· Right click on the icon then select Open from the pop-up menu that appears.
· Double click on the icon 
· Click on the icon then press Enter key.

5.2. Word processing environment

In the environment of a word processor, the following basic tools or features can be used:

· Title bar
· Tabs
· Menus
· Toolbars
· Scroll bar
· Ruler
· Status bar
· Ribbon
· Quick Access Tool bar

Menus:

· File tab
· Home tab
· Insert tab
· Design tab
· Page layout
· References tab
· Review tab
· View tab
· Mailings tab

Scroll bar:

· Vertical
· Horizontal

5.3. working with document
A document can be created, saved, opened, and renamed within the work area.

Creating a document

· Click the File tab.
· Select New on the window that appears, then select Blank document.

Saving a document

There are two main commands used when saving a document which are:

· Save
· Save as

1. Save: It is used when updating an existing document.

· Click File tab then select Save command
Or 
· Press Ctrl + S on the keyboard
Or 
· Click Save icon on the Quick Access Tool bar

2. Save as: It is used when you want to save a new document.

· Saving a document for the first time in the computer.
· Saving the document using a new file name.
· Changing the storage location of a document.

Do the following:

· Click File tab select Save as command.
· Specify the location where the file is to be stored by clicking My computer in the first pane then Documents in the last pane.
· In the File name box, type the name of the file.
· Click the Save button or press the Enter key.

Open an existing document

· Click on the File tab on the menu bar.
· Select Open
· Specify the location where the document was previously stored and the file name.
· Click the Open command.

Renaming a document

· Right click on the document name then select Rename
· Type the new name at the cursor position then press the Enter key.

5.4. Text selection

	Option to select
	Action to be taken

	A word
	Double click anywhere within the word


	A paragraph
	Triple click anywhere within the paragraph


	A sentence
	Press the CTRL key then click anywhere within the sentence

	An entire document
	Press CTRL + A


	A line
	Take the pointer to the left of the line until it changes arrow and the click

	Multiple sequential items
	· Click the first item
· Hold down the shift key and click the last item then release the shift key.



5.5. Basic text formatting

Text formatting: Involves enhancement of the appearance of the text.

a. Font: It includes: 

· Calibri
· Times New Roman
· Arial black
· Arial Narrow, …

b. Font style: Four types of font styles:

· Bold
· Italic
· Regular
· Bold italics

c. Font size: It refers to how small or large the characters are set.

d. Font color: To change the color use Font color box.

e. Underline: A line paced under the letter, word, or sentence.

f. Font effects: Include:

· Superscript Cm3
· Subscript H2O
· Strike through: For draw the line over the text.
· Double strike through 
· All caps
· Small caps
· Hidden

g. Change case: The various types of cases available:

· Sentence case
· UPPER CASE
· Lower case
· Capitalize Each word
· tGGOLE case

Paragraph formatting

It improves the appearance of an entire paragraph. They include:

· Alignment (Left, Right, Center, Justification)
· Indentation (Left, Right, Special indent)
· Line spacing
· Bullets and Numbering
· Borders and shading
· Sorting: For arranging data in a particular order (Ascending or Descending).
· Tabs: Special buttons on the horizontal ruler.

To create borders and shading on table

· Click anywhere within the text.
· Click the Page layout tab, in the box launcher
· Select the Layout tab from the Page setup dialog box.
· Click on the Borders command.
· Select the Borders tab and specify the settings, style, color and width.
· In the Apply to section, specify the area where the border will be effected.
· Click Ok to close the dialog box and effect the changes.



To sort data in a paragraph 

· Select the paragraph. Click on Sort from the Paragraph group in the Home tab.
· Under Sort by, select Paragraphs. Under Type select Text.
· Choose either Ascending or Descending sort orders. Click Ok to apply.

5.6. Proofing features

Proofing: It is the process of reading through a piece of write up in order to find and correct any mistakes before printing.

The features that are used for proofing include:

· Spelling and grammar checker
· Thesaurus
·  Autocomplete
· Autocorrect

· Spelling and grammar checker: It is a feature that contains an inbuilt dictionary for checking spelling and grammatical mistakes.

To make use of this feature:

· Click Review tab from the menu bar. Select Spelling and grammar command under Proofing group.
· To make the correction, select the right word in the Suggestions box and click Change command button.
· To leave the word or phrase as it is, click Ignore button.
· If the word occurs several times in the document, click Ignore all.
· To add the word in the dictionary, click Add button.

Note: Ignore all only appears when there is spelling error.

· Once the spelling and grammar checking process is complete, a dialog box will be displayed. It notifies the user that the spelling and grammar check is complete.
· Click the Ok button.

· Thesaurus: This feature displays synonyms and antonyms of selected word.

To use the thesaurus 

· Highlight the word whose synonym or antonym is required.
· Click Review tab from the menu bar select Thesaurus command under Proofing group.
· Point to the desired word from the resulting list and click on the arrow besides it, select Insert to automatically replace the highlighted word with the selected one.

Moving and copy a section of text

a. Moving a text

It refers to changing the position of the text to a new location.

To move text

· Select the text 
· From Home tab, click Cut icon

Or

· Right click on the selected text and click Cut command from the resulting pop up menu.

Or

· Press CTRL + X on the keyboard
· Position the cursor where the text is to be moved

To paste

· Click Home tab, under the Clipboard group, click Paste icon.
· Right click and select Paste command and from the pop up menu.

Or

· Press CTRL + V on the keyboard.

b. Copying text

Copying: Refers to creating a duplicate of text.

To copy

· Select or highlight the text or document to be copied.
· Use one of the following options:

· From Home tab, click Copy icon under the Clipboard group.
· Right click on the selected text and click Copy command from the pop up menu.
· Press CTRL + C on the keyboard.
· Position the cursor where the item is to be copied.
· To paste, use one of the following options:

·  From Home tab, click Paste icon under the Clipboard group.

Or

· Right click and click Paste command.

Or

· Press CTRL + V on the keyboard.

Moving through the text

a. Moving through a document using keyboard shortcut

When they are used, the position of the cursor is automatically changed.

	Press keys
	To move

	Page down (Pgdn)
	Down one screen


	Page up (Pgup)
	Up one screen


	End
	To the end of the current line


	Home
	To the beginning of the current line


	CTRL + Home
	To the beginning of the document


	CTRL + End
	To the end of the document




b. Scrolling through the text

Scrolling: Is the process of moving around a document without changing the position of the cursor.

Vertical scroll bar: Is used to move up or down the pages.

Horizontal scroll bar: Is used to scroll from side to side.

	To scroll bar
	In the vertical scroll bar

	Up on line at a time
	Click on the up scroll arrow


	Down one line at a time
	Click on the down scroll arrow


	Multiple pages up or down the document
	Drag the scroll box to the top, bottom or middle of the scroll bar

	To the previous page
	Click the double up arrow


	To the next page
	Click the double down arrow




Deleting text or image in a document

To delete text or image: Refers to remove or erase content such as words and picture from a document.
Deleting can be done using:

· Backspace key
· Delete key

· Backspace key: Erases character by character from the left side of the cursor position to the right.

· Delete key: Erases character by character from the right side of the cursor positon to the left.

Typing modes

There are two typing modes used to edit documents. These are:

· Insert mode
· Type over mode

a. Insert mode: It is a typing mode that adds text between words at the insertion point without replacing them as the user types. It is the default typing mode.

b. Type over mode: It is also referred as Over type mode. In this mode, the text added at the cursor position automatically deletes and replaces the existing text.
To active over type mode

· Press the Insert key on the keyboard. To switch back to insert mode, press the Insert key again.
· From File tab, click Options. From the Word option dialog box, click the Advanced tab then click on the box next to use over type mode.

Undo and Redo commands

a. Undo command: Is used to cancel or negate a series of the last commands executed starting with the most recent in order to restore the status of the document.

The undo command is executed using one of the following options:

· Press CTRL + Z on the keyboard

Or

· Click on the Undo command icon on the Quick Access Tool bar.

b. Redo command: Is activated only when the undo command had been used earlier. It nullifies a series of the negated actions. 

It executed using one of the following options:

· Press CTRL + Y on the keyboard
· Click on the Redo command icon on the Quick Access Tool bar.

Find and Replace

Find command: Is used to locate a word or phrase within a document.

Replace command: Is used to automatically substitute the located word with a new word.


· Find command

The steps followed to locate words

· Click on Home tab on the menu bar
· In the Editing group click on the Find command.
· Type the word to search in the Search document box. Press the Enter key.
· Click on the Close button. Or CTRL + F.

· Replace command

To replace an existing word on phrase with a new one 

· Click on Home tab on the menu bar.  In the Editing group, click on the Replace command.
· Type the word to be replaced on the Find what box, and the word to substitute in the Replace with box.
· Click on the Find next button to locate the word in the document.
· Click on Replace button to locate the word in the document. Or click on the Replace All button to substitute all the occurrence of the word in the document at once.
· Click Cancel button to stop the procedure and close the dialog box.


UNIT 6: WORD PROCESSING BASICS II


INTRODUCTION

By the end of this unit, you should be able to:

· Manipulate a document
· Use advanced formatting methods in a document
· Add simple objects in a document

6.1. manipulating a document

A document can be formatted and edited in order to make it error free and appealing. This can be achieved through different ways for example:

· Page setup of a document
· Proofreading 
· Adding breaks
· Styles
· Columns
· Nested list, …

6.1.1. Page setup group

It is used to specify the margins and the orientation of a page among other specifications.

i. Setting margins

Page margins: Are the blank spaces around the edges of a page.  some items like Headers, Footers, and Page numbers can be positioned in the margins, 

To set the margins

· Click Page layout tab, from the Page setup group and click Margins command.
· Click the margin type desired from the pull down menu that appears.

To set a customized margin

· Click Margins, then select Custom margins command on click on the dialog box launcher at the bottom of Page setup group.
· Click on Margins tab on the dialog box that appears.
· Specify all the desired options, and click Ok to apply.

ii. Orientation

Page orientation: This refers to the position of the page in relation to the text or graphics. 

There are two types of page orientation:

· Portrait
· Landscape

· Portrait: This is where text and graphics are printed with the longest side placed vertically and the shortest placed horizontally.

· Landscape: This is where text and graphics are printed with the longest side placed horizontally and the shortest placed vertically.

Change the page orientation of an entire document

· Click on the Page layout tab, in the Page setup group, click orientation.
· Select either Portrait or Landscape.

Using both portrait and Landscape orientation in the same document

· Select the content on the pages or paragraph(s) whose orientation is to be changed to portrait or landscape.

Note: If some but not all of the text on a page is selected, put the selected text on its own page.

· Click on the Page layout tab, in the Page setup group.
· Click Margins, then select Custom margins command or click on the dialog box launcher in the Page setup group.
· Click on the Margins tab on the dialog box that appears.
· Under the Orientation section, choose Selected text option.
· Click Ok to apply.

iii. Page borders

· Click anywhere within the page. Click the Design tab, in the Page background group, click on Page borders.
· Specify the settings, style, color, art, and width.
· In the Apply to section, specify the area where the border will be effected.
· To customize the margin, click on Option button.
· Click Ok to close the dialog box and effect the changes.

iv. Background

It is also known as the Page color.

Adding a background to a document

· Click on the Design tab, in the Page background group.
· Click Page color icon 
· Do one of the following:

· Click the desired color under Colors
· Click More colors and then select a desired color
· Click Effects to add special effects.

To remove a background

· Click on the Design tab, in the Page background group.
· Click on Page color
· Select No color

v. Watermark

Watermark: Is a text or picture that appears behind text in a document.

Adding a watermark to a document

· On the Design tab, in the Page background group, click Watermark icon.
· Do one of the following:
· Select one of the predesigned watermarks
· Select Custom watermark command 
· Select wither Picture watermark or Text watermark options. Click on Select picture button and insert the appropriate picture.
· If text watermark option is selected, type the appropriate text in the Text box. Click Ok.

To remove a watermark

· Click on the Design tab in the Page background group, click Watermark.
· Click on Remove watermark command.

6.1.2. Proofing features

a. Track changes

It enables the user to view all the changes that have been done.

To turn on track changes

· Click on the Review tab in the menu bar, in the Tracking group, click the icon. Click on Track changes again.
· To add a track changes indicator to the status bar, right click the status bar and click Track changes. Then click the Track changes indicator on the status bar to turn track changes on or off instead of using the menu option.

b. Comments

Comment: Is a note that an author or a viewer adds to a document.

Add a comment

· Select the text or item or click at the end of the text.
· Click on the Review tab, in the Comments group, click New comment.
· Type the desired response in the new comment ballon.

Deleting a comment
· Right click the comment, and then click Delete comment or click on it then select Delete command in the Comment group from the Review tab.
· To quickly delete all comments in a document, click a comment in the document. On the Review tab, in the Comments group, click the arrow below Delete icon, and then click Delete all comments in document.

c. Word count

When a document is being typed, Ms word automatically counts the number of pages and words in the document and displays them on the status bar at the bottom of the workspace.

If the word count is not displayed in the status bar, right click the status bar then and click Word count option. 

Counting the words in a selection

Select the text to be counted. Ms word will automatically display the number of words in the select at the status bar.

Wonting the number of pages, characters, paragraphs and lines

Word count dialog box displays the number of pages, paragraphs and lines in a document. it displays the number of characters, either including or excluding spaces.

To view the word count

· Click on the Review tab
· In the Proofing group, click Word count


6.1.3. Columns and Breaks

a. Columns

They are created to enhance the look of a document. they can be created using predefined or user defined options.

Predefined columns

To create a column

· Select the text
· Click Page layout tab from the menu bar, then click on the Columns command under Page setup group.
· Click on the number of columns desired from the drop down menu displayed.

User defined columns

· Select the text
· Click Page layout tab from the menu bar then click on the Columns command under Page setup group.
· Select More column option from the resulting pull down menu.
· Specify the column width, and spacing line between columns, number of columns, and where the columns is to be applied.
· Click Ok.

b. Breaks

A break: Is inserted in order to demarcate the end of part and beginning of another.

There are 4 types of breaks:

· Page break
· Column break
· Section break
· Text wrapping break

1. Page break: It demarcates the end of one page and the beginning of the next.

To insert a page break

· Place the cursor where the page break is to be inserted.
· Click Insert tab, then click the Page break under Pages group.

2. Section break: It is used to make other formatting changes on different pages in a document, including:

· Page size or orientation
· Headers and footers
· Page numbering
· Line numbering 
· Footnote and endnote numbering

To insert a section break

· Click Page layout tab, in the Page setup group, click Breaks.
· Select the desired type of section break.

3. Column break: It is used to indicate that the text following the column break will begin in the next column.

To insert a column break

· Click at the position where the column break is to be inserted.
· Click on the Page layout tab, select Breaks in the Page setup group and then click Column.

4. Text wrapping break: It is used to separate the text around objects on a page.

To insert a text wrapping break

· Click on the page where the wrapped text is to end.
· Click on the Page layout tab, select Breaks in the Page setup group and then click Text wrapping.

Note: Text wrapping break are formatting marks that aren’t usually visible in a document. to view these breaks, turn on the formatting marks by clicking Show / Hide in the Paragraph group on the Home tab.

6.1.4. Formatting text

· Styles
· Nested lists
· Drop caps
· Headers and footers

1. Styles

a. Headings: These are styles that have been defined in word processing application.

There are 4 main heading styles:

· Heading 1
· Heading 2
· Heading 3
· Heading 4

Those are used when the user wants to create a table of contents.

b. Apply a style: Click on the Home tab, in the Styles group, select a set of styles desired. Apply the styles from the convenient Quick styles gallery as the document is being created.

c. Create a style: It creates a style based on the formatting of the selected text.

To create a style and add it to the Quick styles gallery

· Select the text to be used to create the new style.
· On the Mini tool bar that appears above the selection, select Styles, then Heading 1 and finally click on Red color to format the text.
· Give the style a name, then click Ok or Modify.

Clear formatting

· Select the text whose style is to be erased.
· Right click the selection, click on Styles, and select Clear formatting command.

2. Nested lists

Nested lists: Refers to lists at different levels (Sub – lists) that is a list within another list.

Bullets and numbers: Are used for the purposes of easier identification of items in the list.

To create a nested list

· Create the list with each item on its own line shown below:

Vegetables
Fruits
Cereals

· Select the list then, click on the Numbering or bullets icons from the Home tab in the Paragraph group.
· From the resulting menu, select the desired type of bullet or numbering list to automatically apply it.

For example:

· Vegetables
· Fruits
· Cereals

To create a nested numbering list under vegetables

· Click at the end of the word vegetables

a. Vegetables
· Cabbage

· Press the Enter key and then press on the Tab key. A number is automatically inserted.

To close the current list level

Press the Enter key twice or press Shift + tab.

3. Drop caps

A drop cap: Is a large capital letter usually at the beginning of a block of text that has the depth of more than one line of regular text.

To set a drop cap

· Highlight any character with in the line of text where the drop cap is to be inserted.
· Click on the Insert tab, select Drop cap icon under text group.
· A drop down menu is displayed 
· Select either the Dropped or In margin option

To customize the options

· Click on the Drop cap options. Specify the position of the text, the number of lines to drop, font and distance from text.
· Click Ok.

4. Headers and footers

Headers: Are lines of text or graphics that appear above the top margin of a page or selected pages.

Footers: Are lines of text or graphics that appear below the bottom martin of a page or selected pages.

To insert a header and footer

· Click Insert tab from the menu bar, then click on Header or footer command from the ribbon.
· Under Header & Footer group, type the desired content to insert a header or footer respectively. Then press Enter.
· Click on the desired option

Page numbering

To insert page number

· Click Insert tab on the ribbon that appears
· Click on Page number from Header and Footer group.
· Click on the Page number icon.
· Choose the preferred option.


UNIT 7: NETWORK AND INTERNET FUNDAMENTALS

INTRODUCTION

By the end of this unit, you should be able to understand the rationale of a computer network and use the internet efficiently and effectively.

7.1. Computer network concepts

7.1.1. Definition of network

A network: Is generally described as a system or group of interconnected objects or people.

7.1.2. Definition of computer network

A computer network: Is a set of interconnected computing nodes which communicate with one another through a transmission medium using a set of rules. The nodes share resources and services.

7.1.3. Characteristics of a computer network

· Security
· Reliability
· Transmission capacity

a. Security: It must provide protection data from unauthorized access.

b. Reliability: It should work consistently to perform according to its requirement.

c. Transmission capacity: It must have two or more computing nodes connected using a transmission medium.

7.1.4. Role of a computer network

· Store data centrally for ease access and backup.
· Communicate with other network users.
· Share resources

7.1.5. Advantages and disadvantages of a computer network

Advantages

· Resource sharing 
· Speed
· Communication
· Work group computing
· Security
· Increased storage capacity
· Entertainment

Disadvantages

· Expensive to install and maintain
· Failure of the server and other hardware
· Insecurity of information
· Spread of computer viruses

7.1.6. Classification of computer network according to geographical areas

Types of networks

There are 4 main types of computer networks classified according to geographical areas.

· Personal Area Network (PAN)
· Local Area Network (LAN)
· Metropolitan Area Network (MAN)

a. Personal Area Network (PAN)

It is also known as Wireless Personal Area Network (WPAN). It is a smallest network used for data transmission among devices within the environment of an individual.

These devices may include:

· A wireless printer
· A telephone
· A TV remote control
· A wireless computer keyboard
· A wireless computer mouse

Bluetooth: Is a wireless protocol that connects electronic devices over a short distance of up to about 10 meters creating a PAN with a high level of security.

Infra-red: Is a wireless electromagnetic energy technology with a wavelength longer than those of red visible light.

It is used in conveying data from one device to another.

b. Local Area Network (LAN)

It is a network that covers a small geographical area for example, an office, a building, an institution, or an organization.

c. Metropolitan Area Network(MAN)

A metropolitan Area Network covers a city or town. It can be made up of many LANs and can provide internet connectivity in a Metropolitan region.

Differences between LAN and WAN

	Local Area Network
	Wide Area Network

	Covers small geographical area
	Covers a very large geographical area usually world wide

	Transmits data at high speeds because of small distance covered.
	Transmits data at lower speeds because of very large distance covered.



7.2. Internet concepts

7.2.1. Definitions

Internet: Internet stands for International network.  It is world wide network of computers connecting millions of computer networks via communication media such as telephone lines, wireless connections, and fiber optic.

World Wide Web (WWW): It is commonly referred to as the web. WWW refers to as large virtual space in the internet where information pages called web pages are installed.

Web page: Hypertext and hypermedia documents containing information about an individual or organization.

Web site: A collection of related web pages stored as a single file in a web server. 

Web browser: It is commonly referred to as a browser. These are programs used for displaying and viewing web pages on the world wide web (WWW).
URL: It is an abbreviation for Uniform Resource Locator. A web address is commonly known as URL.

URL consist of 3 parts:

· Protocol
· Server name
· Resource ID

Example of URL: http://www.techrwanda.com

ISP: This is abbreviation for Internet Service Provider (ISP). It is a licensed organization company that provides access to the internet usually at a fee.

7.3. History of the internet

7.3.1. Development of the internet

In 1960: For the purpose of information and research sharing.

In 1962: Packet switching was developed and it formed the basis of internet connection.

In 1969: ARPANET began working on an experiment to determine whether computers at different universities could communicate with each other without a central system.

ARPANET: Advanced Research Projects Agency

In 1970: Vinton Cerf and others, published a proposal for protocols and later ARPANET began operating Network Control Protocol (NCP) to enable computers to communicate.

In 1974: Vinton Cerf together with Bob Kahn presented their protocol for packet network interconnection, which became the basis of the modern internet.

In 1978: ICP / IP was split into two protocols TCP / IP (Internet Protocol).

In 1982: TCP / IP was established as the protocol for ARPANET and by January 1983, all of the ARPNET was switched over from NCP to TCP / IP.

In 1991: - The first World Wide Web (WWW) files were made available on the net for downloading using File Transfer Protocol (FTP).

· The introduction of search engines.

In 1993: The world started waking up to the WWW and at least 200 known HTTP servers were connected.

In 1994: Netscape communication was born and Microsoft created a web browser for windows 95.

In 1998: Google search engine was born changing how users engaged with the internet.

Today: The internet is everywhere, enabling people to communicate and share interests in many ways more faster using sites such as:

· Facebook
· Twitter
· Linked-In
· You Tub
· Blogs
· Wiks, …

7.3.2. Internet uses in daily life

Internet can be used in the following ways in daily life:

· Communication 
· Research
· Business
· Education
· Medicine
· Internet banking
· Entertainment

7.3.3. Methods / ways of connecting to the internet

· Dial up
· Broadband
· Wi-Fi

· Dial up: It involves connecting a computer to an internet service provider (ISP) by use of a modem and telephone line such as subscriber identity, Identification Module Card (SIM) only when accessing the internet.

· Broadband: This is high capacity transmission technique that used a wide range of frequencies to enable a large number of messages to be communicated simultaneously.

Some examples of broadband

· Wi-Fi
· 4G
· Satellite

· Wi-Fi: Wi-Fi stands for Wireless Fidelity. This is a wireless Fidelity. This is a wireless network technology that uses radio waves to provide high speed internet and networking connections.

Wi-Fi enabled services includes:

· Laptops
· Cell phones
· Tablets
· Ipads
· Peripheral devices such as the mouse, printers, and keyboards, …

7.3.4. Getting online

Web browser: Is a program that is used for displaying and viewing web pages on the world wide web (WWW).

Examples of web browser

· Mosaic
· Netscape navigator
· Internet explorer
· Mozilla fire fox
· Opera mini
· Google chrome, …

Basic parts of a web browser

· Title bar
· Menu bar
· Control buttons
· Address bar
· Search text box
· Search button
· Search Query

1. Title bar: Where title is displayed.
2. Menu bar: It consists of a list of menus to choose from. (File, Edit, View, Tools, and Help)

3. Control buttons: These buttons are found on the far right side of the title bar of the search engine and include the following:

· Minimize
· Restore down
· Maximize
· Close

4. Address bar: This is where an address or (name) is typed so as to go to a given web page.

Example of a web site address: www.techrwanda.com

5. Search text box: This is where key words are typed to describe the information that one wants to find.

6. Search query: It is the information typed by the user to help the search engine decipher the required information.

Web address

A web address: Is commonly known as Uniform Resource Locator (URL). It is a unique address of each web page in a web sites which identifies the location of a specific web page on the internet.

It consists of three parts:

· Protocol
· Server name
· Resource ID

· Protocol: It is a set of rules that govern how data is transmitted in a network.

Example: http (Hypertext Transfer Protocol)

· Server name: It identifies the computer on which the resource is located. This computer is known as Remote server.

Example: www.techrwanda.com

Note: Most web server names begin with the letters www. It always ends with a dot and a three or two letter extension called the domain name.


The domain name system (DNS)

Is a class or naming order system for computers, services, or any resources connected to the internet or a private network.

Note: Domain is important because it usually identifies the company, agency or organization that is directly responsible for the information or is providing the compute space where the information is kept. Sometimes it indicates the country where the server is located.

A top level domain (TLD): Is a domain at the highest level in the domain name system of the internet.

Examples:

· .com: Which identifies company or commercial sites
· .org: For non-profit organizations sites
· .go: For government agencies sites
· .net: For internet service providers
· .ac: For academic / educational institution
· .co: For company
· .mil: For military organization

Examples of country domains:

· .rw: For Rwanda 
· .ke: For Kenya
· .uk: For United Kingdom
· .jp: For Japan
· .tz: For Tanzania
· .us: For United States
· .au: For Australia
· .ca: For Canada

7.4.  Search engines

7.4.1. Definition

Search engines: Are programs that help a user to look for and identify items that corresponds to keywords or phrases specified from the world wide web.

7.4.2. Advantages and disadvantages of search engines

Advantages

· They provide precise results
· They have indexes representing important parts of the internet which offer a wide range of information resources.
· They enable users to describe the information being searched.
· They enable users to locate and access information in different web sites.
· They reduce the time taken to locate desired information.
· They provide a wealth of information for professional and personal use.

Disadvantages

· Tire some and complex to search if the keyword typed is ambiguous.
· A lot of irrelevant information gets displayed after typing a keyword.
· A lot of distractions form advertisements that keep on popping up.
· A link to sites containing viruses could be displayed as a search result.

7.4.3. List of search engines

a. Google
b. Bing
c. WiseGeek.com
d. Wikipedia
e. Google scholar
f. Ask.com
g. Yahoo!

7.4.4. Deciphering search results

Deciphering: Is a conversion of text written in code form into natural language.

Procedure for deciphering search results

· Type your search query in the search box.
· Click on the search button.

The result is displayed with the following sections:

· Search box
· Search verticals
· Page count
· Time the search took
· Related searches
· Images
· News results
· Sponsored links
· Organic results
· Pagination
· Disambiguation

· Click on one of the options within the sections to access the web page.

7.5.  Electronic mail (E-mail)

7.5.1. Definition

E-mail: Refers to a system of exchanging messages electronically over computer network.

7.5.2. E-mail address

The following is a sample format of an e-mail address:

username@hostcomputer.domain name

Explanation

· User name: It identifies the owner of the e-mail address.

· @ (at sign): Separates the user name from the rest of the address parts.

· Host computer: The name of the remote server on which the email account is hosted.

Examples: 

· Gmail
· Yahoo
· Hotmail

· Domain name: It identifies the type of institution offering the services.

Example of e-mail address: nkeza@gmail.com
nkeza: User name

gmail: Host computer

.com: Domain name for a commercial organization

7.5.3. Advantages and disadvantage of e-mail

Advantages

· It allows sending of one mail to may recipients at the same time.
· It is cheaper compared to traditional mails.
· It is fast and efficient as it allows instant sending and receiving mails from anywhere in the world.
· E-mails can be saved for future retrievals in another computer.
· It is easily to reply and forward mails.
· Allows sending and receiving of any format of information.

Disadvantages

· Use of e-mail requires computer literacy to use.
· E-mail are not accessible to everyone due to internet connectivity problems.
· There are security concerns. (For hackers)
· Allows spread of virus such as hoax.

7.5.4. Creating an e-mail account

Follow these steps

· Open the e-mail application software.
· Select Check mail option.
· Click Sign up and follow the procedure in the application.

When creating a password for the account ensure that the password is strong enough.

A strong password should:

· Have a minimum of 8 characters
· Be a mixture of both letters, numbers and if possible symbols.

Note that:

· Passwords are case sensitive
· Always use a combination of characters that you can easily remember.
· Avoid using characters that can be guessed.
· Passwords are always encrypted for security purposes.

Sending and reading messages

Before sending and reading a messages, the user must open their account. The referred to as Signing in.

Sign In

To sign in to an existing account 

· Open the web browser software installed in the computer.
· Open the e-mail application program to display the sign in window.
· Type the e-mail address under User name box and password under the Password box.
· Click Sign in button to open the e-mail


Receiving a message


Upon signing in, the user’s inbox is automatically opened. The messages are displayed in three columns showing:

· Name of the sender
· The subject
· The date / time when the mail was sent.

To read a message, click on the Subject.

The user can decide to select one of the following options available on the message window:

· Reply
· Reply all (CC, BCC, To box)
· Forward
· Move

Note: 

· Deleting the message only send it to the Trash folder.
· To permanently delete the message, empty the trash folder

Sending messages

User can either compose a new message or send on that already exists in their in box.

To compose a message

· Click on the Compose button in the e-mail account window.
· Click at To text box and type the e-mail address of the recipient.

Note: To send the same message to a number of people the following options can be used:

· CC (Carbon Copy)
· BCC (Blind Carbon Copy)

· CC (Carbon Copy): When this option is used, the list of all the recipients appears in each recipient’s mail.

· BCC (Blind Carbon Copy): When this option is used, the list of all the recipients is hidden from the other recipients of the mail.

· Click at Subject text box to type the title that describes what the e-mail is about.
· Click Send button once the message is completed.

Organize e-mail message

The ways of organizing an e-mail

· Move
· Delete
· Add or switch folders
· Address book

a. Move

An e-mail in the inbox can be transferred from the in box to another folder.

The procedure for this

· Select the e-mails to be stored to be moved at once.
· Move the e-mail into the folder by clicking the Move to button at the top of the e-mail list and select the name of the folder from the drop down.


b. Delete

An e-mail can be erased from the account using either of the following procedures:

· Click on the e-mail and then click the Delete button.

Or 

· Right click on the e-mail message and click Delete from the pop up menu.


c. Add or switch folders

· On the left side of the page, click More at the button of labels list.
· Click create New label.
· Type the name of the new label and click Create.
· Gmail does not use folders. Instead, it uses labels to help the user organize the mails more effectively.

Comparison between labels and folders

	Labels
	Folders

	A conversation can have more than one labels

	You can only put a message in one folder.

	A conversation can be in several locations (Inbox, All mail, Sent mail, …) at the same time, making it easier to find later.
	You have to remember where you filed a message to retrieve it.

	You can search conversations by label.

	You can’t always do folder specific searches.



d. Address book

Address book: Is an Online contact manager used to store all contact information and it makes it easy to keep track of names, e-mail addresses, phone numbers, fax numbers and a lot more.

It is possible to add a contact to the address book from an e-mail message.

To add names to the address book

· Click on Add contact option.
· Type the details of the contact requested.
· Click Add on the dialog box. The window is automatically closed.

Using the address book

· Once a contact exists in the address book, when the user starts typing thee e-mail address, a list of all the possible contacts that match it are displayed.
· Select the desired contact.
· Press the Enter key.

7.5.5. Uploading / Attaching a document to an e-mail

It is possible to attach one or more files to an e-mail address. The attachment could be:

· A Microsoft word document 
· File
· Spreadsheet
· Sound file
· Video file
· Picture file, …

To attach a file 

· Click on the Attach command button.
· Select the file to be attached then click Open button.
· Once the procedure is complete, click the Send button.

Note: Once the message is sent, a copy is stored in the Sent folder.


Downloading information from Net

Downloading: Is the process of getting information from the internet.

To download a file

· Click File on the page to be downloaded.
· Select Save as option and follow the procedure for saving a document.

To print the page without saving

· Click File on the page to be downloaded.
· Select the Print option and follow the procedure for printing a document.


UNIT 8: MUSIC SPRITE PROGRAMMING
8.1. INTRODUCTION

By the end of this unit, you should be able to create a music sprite and add music with scratch and audacity.

Scratch: Is a free programming language that allows creation of interactive games, animations, music and stories that can be shared around the world.

A sprite: Is an object that performs actions in a project.

8.2. Scratch 2.0 user interface

· Stage area
· Sprite list
· Scripts tab
· Scripts area

1. Stage area: It displays the sprite(s) and the results. It contains:

· View full screen 
· Project title
· Green flag
· Stop button

a. View full screen: It makes the stage area to cover the whole screen.

b. Project title: This is the name of the project. It only appears after the project has been saved.

c. Green flag: It is used for starting all scripts in a project.

d. Stop button: It stops all scripts in all sprites.


2. Sprite list: It is located at the bottom left area of the scratch window and display sprites as thumbnails.

Thumbnail: Contains information about the selected sprite and tools for manipulating the sprite.

To change the sprite’s name, simply click in the box labelled Sprite1 and type the preferred name.

3. Scripts tab: It contains block that can be dragged on to the scripts area to make a project.
It organized into 10 groups of block palettes:

· Motion
· Looks
· Sound
· Pen
· Data
· Events
· Control
· Sensing
· Operators
· More blocks

a. Motion blocks: They are used to control how sprites move and change angles or direction.

b. Looks blocks: They are used to control how sprites appear.

Example: For changing sprite color and making the sprite larger or smaller among others.

c. Sound blocks: They are used to control sound and play audio files.

d. Pen blocks: They are used to draw by controlling pen width, color, and shade.

e. Data blocks: They contain variable blocks and list blocks.

f. Event blocks: They contain vent handlers which are placed on top of each group of blocks to activate scripts to run.

g. Control blocks: They are used to direct scripts.

Examples:

· Forever
· If then
· Wait until
· Repeat until

h. Sensing blocks: They are used to interact with the surrounding of a project.

i. Operators blocks: They contain mathematical operators and strings that compare sprite positons.

j. More blocks: They contain custom procedures (blocks) and extensions for the selected sprite. It contains Make a block and Add an extension button that allow the user to create more blocks.

4. Scrips area: It is where blocks are combined to form scripts which in turn form a project.

Other tabs in scratch user interface windows include:

· Costumes
· Sounds
· Help
· Stage backdrop pane

a. Costumes tab: It contains a list of costumes for the selected sprite.

A costume: Is a frame or other appearance of the sprite.

To add new costumes, click one of the following buttons:

· Giga button
· Paint brush button
· Import / Folder button
· Camera button

· Giga button: It opens the built in costume library on sprites from which a costume can be chosen.

· Paint brush button: It opens the paint editor and is used to paint new costumes.

· Import / Folder button: It opens a file browser and is used to upload sprite or image from a file.

· Camera button: It opens a camera and is used to create new costume from camera.


b. Sounds tab: It contains a list of audio clips and is used to insert sounds and music to a sprite.

To add new sound, click one of the following:

· Speaker icon
· Record button
· Import / Folder button
· Speaker button: It opens the sounds library.

· Record button: It opens the sound recorder that enables sound to be recorded from an external device.

· Import / Folder button: It opens a file browser and is used to upload sound from file.


c. Help tab: It displays help information about a particular block.

To get information about a particular block

· Right click on the Help command that pops up.
· Click on the Help button. Its icon is a question mark to expand.
· Click on the Close button to minimize.

d. Stage backdrop pane: It refers to a frame or background of the stage. It is used to choose a backdrop from the library, paint new backdrop, upload backdrop from file and add new backdrop from camera.


The scratch toolbar

This toolbar is used to carry out very important functions. It contains menu options:

· File
· Edit
· Tips
· About

a. File menu option: Clicking on the dropdown arrow next to File displays the following menu options:

· New 
· Open
· Save as and save
· Share to website
· Check for updates
· Quit

b. Edit menu option: Clicking on the dropdown arrow next to Edit displays the following menu options:
· Undelete
· Small stage layout
· Turbo mode

c. Tips: Opens the help area.

d. About: It is an online feature that connects the user to the scratch website.

Other cursor tools on the toolbar include:

· Stamp tool / Duplicate button
· Delete button
· Grow button
· Shrink button
· Block help button


Create / Import a sprite

Importing: It refers to the processes of transferring an existing image into a program.


8.2.1. Create a new sprit or import the existing image

There are four buttons used to create a new sprite or import an existing image, namely:

· Giga button
· Paint brush button
· Import / Folder button
· Camera button

a. Giga button: It opens the built in sprites and enables the user to choose a sprite from the library.

To create a sprite using the Giga option:

· Click on the Giga button
· Double click on the desired sprite or select the desired sprite and click Ok.

b. Paint brush button: It opens the paint editor and is used to manually draw the sprite with color tools provided by scratch.

c. Import / Folder button: It opens a file browser and is used to upload a sprite or image.  

Select the location from where to upload the sprite, select the file name then click Open.

d. Camera button: It opens a camera which would be able to create a new sprite.


8.2.2. Practical activity: Using Combo blocks to play sounds

The default sound in the “Play sound” … “until done blocks” is Meow.

· Click on Sounds tab to display the Sound library. Select the preferred sound from the library or any other source.

· Double click the preferred sound or click on the sound then click Ok. The selected sound appears as a thumbnail under Sounds tab or in the Play sound block under the Scripts tab.

· To select any other sound, click the Dropdown arrow in the Paly sound block.

· Drag the Blocks under the Sound tool kit and click the Dropdown arrow to select the sound.

· Click the Control tool kit, drag Forever block to enclose the sound blocks.

· Click the Events tool kit, drag the When () clicked to the top of Forever block.

· Click the Green flag to play the sound.

Note: To play a scripts, the user can click on the Green flag button or on the script.


8.2.3. Choose the sprite especially from the Things folder

Things folder: Refers to the folders in scratch that contain sprites. The Sprite library contains various folders with different names. 

Examples: 

· Letters
· People
· Things, …

To choose a sprite from the things folders
· Click on the Giga button to open the sprite library.
· Click on the Things folder to open.
· Select the desired sprite.

8.2.4. Manipulation of variables to program switch On and switch Off

A variable: Is a changeable value that can only hold one value at a time. It is created from the Data blocks on the Script tab using the Make a variable button.

Clicking on this button displays the New variable dialog box that enables the user to name the variable and specify its scope.

Types (Scope) of variables

There are three types of variables:

· Local (Private)
· Global (Public)
· Could

1. Local variable: It is a variable that can only be changed by the sprite that owns it. It can be read by other sprites using the Change () by () block but they cannot change it.

A local variable is created by selecting For this sprite only option button in the New variable dialog box.

2. Global variable: It can be read and changed by any sprite in the project. By default, For all sprites option button is selected meaning that it is a Global variable.

3. Could variable: It is stored in the could (on the scratch server).


8.3. Create a tune using the sound tool kit

Tool kit: Is used to add a music script to a sprite.  The sound tool kit is displayed by clicking on the Sound block under the Scripts tab.


8.3.1. Practical activity: Creating a tune using the sound kit

To add a music script to a sprite

· Select the Sprite to which you want to add music.
· Click the Sound tab block under Scripts tab.
· Add the desired music using the blocks under the Sound block.
· You could, for example, drag the block to the scripts area to play a Soh-fa notation.
· Click the dropdown arrow on the block to display the keyboard.
· Double click on the blocks to play the sounds.
· To add pause between notes, use the block that reads, Rest for 0,2 beats.

8.3.2. Practical activity: Creating a sound clip using Audacity

Audacity: Is a free, open source software that is used for recording and editing sounds.

To use the Audacity program

· Open the Audacity program.
· Start playing the preferred sound clip or song using any of the players on the computer.
· Select Stereo recording.
· Click the Record button to start recording.
· Click the Stop button to stop recording.
· To import the recorded sound, clip or song to a sprite, select the Sounds tab and click Import button to upload sound from file.

8.3.3. Practical activity: Creating a song using Sound tool kit 

To create a song using Sound tool kit

· Click Sounds tab
· Create a new sound (s) as discussed under Sounds tab above.
· The created sound is added to the Play sound and Play sound … until done blocks.
· Click on Scripts tab and select Sound.
· Drag Play sound or Play sound …until done blocks into the scripts area.
· Click the dropdown arrow on the block and select the preferred song.


UNIT 9: GEOGRAPHIC INFORMATION SYSTEMS (GIS) AND MAPS

INTRODUTION

GIS: Is a system designed to capture, store, manipulate, analyze, manage, and present all types of geographically referenced data; that is, data identified according to their location.

Geographic information systems cover the following areas among others

· Natural resources: Forestry management
· Community services: Fire, ambulance, police
· Health
· Water resources
· Minerals: Oil, natural gas
· Education: School distribution
· Mapping natural phenomena: Occurrence of volcanoes

9.1. Components of ArcGIS

There are 3 ArcGIS desktop applications namely:

· Arc Catalog
· Arc Map
· Arc Tool box

1. Arc Catalog: This application is used for managing spatial data contained in the computer and other locations, managing database designs, recording and viewing metadata.

2. Arc Map: Is a mapping application that allows the creation of maps and query attributes and analyzes spatial relationships and layout of the final projects.

3. Arc Tool box: This application is used for data conversion and geoprocessing.

These three applications can perform any GIS tasks including:

· Mapping
· Data management
· Geographic analysis
· Data editing
· Geoprocessing

9.2. Defining terms and concepts of GIS

· Java edition (AEJEE): Is abbreviation for Arc Explorer – Java Edition for Education. It allows viewing and querying local data as well as Arc IMS services from the geodata.gov or other hosted sites.

· Post GIS: It is used for storing, manipulating, and retrieving such as distance, area, and intersection to the database.

· Arc Explorer: it performs a variety of basic GIS functions including display, query and data retrieval applications.

· Layers: Are the methods used to display geographic data sets in Arc GIS.

· Raster data: Are items, usually images that are composed of pixels.

· Vector data: Images such as streets, rivers, railway lines, lakes, city blocks, and any other features that can be drawn on a map. These are represented by (X , Y)

Different kinds of vector data

· Points
· Lines

· Points: Is used to display individual location.

· Lines: Are used to represent linear features such as road, trails, streams, and contour lines.

9.3. The interface of Arc Map

The interface of Arc Map normally consists of:

· Table of contents (TOC)
· Menu bar
· Status bar
· Toolbars

9.3.1. Table of contents (TOC)

It is used to manage the contents of the map display. It lists all the layers on the map.

The table of contents has the following command buttons:

· List by drawing order
· List by source
· List by visibility
· List by selection
· Options

a. List by drawing order: The layers are listed by the geodatabase or folder containing the data source they reference.

b. List by visibility: The layers are listed according to whether they are turned ON or OFF.

c. List by selection: The layers are listed whether their features are selectable by the interactive selection and editing tools.

d. Options: It is used to change the behavior and appearance of the table of contents.

9.3.2. The menu bar

The menu bar has options such as:

· File
· Edit
· View
· Bookmarks
· Selection
· Geoprocessing
· Customize
· Windows
· Help

a. File tab

It has the following commands:

· New
· Save
· Save as
· Save a copy
· Share as
· Add data
· Print
· Print preview
· Export maps

b. Edit tab

It has the commands like:

· Undo
· Redo
· Cut
· Copy
· Paste
· Paste special
· Delete
· Copy map to clipboard

c. View tab

It has the commands like:

· Data view
· Layout view
· Graph
· Scroll bar 
· Status bar
· Reports
· Data frame

Arc Map provides 2 ways of viewing a map:

· Data view
· Layout view

d. Book marks

It is a tool kit that can be used to save a feature to a map. It provides short cut to a place on a map.

A spatial book mark: Is an electronic marker in a map.  It identifies the geography of the map for future reference or retrieval

9.3.3. File handling with Arc Map

Arc Catalog organizes spatial data stored.

Arc Catalog: Data management

To open the Arc Catalog, double click on the Arc Catalog icon on the desktop. The screen lists a set of possible location for data in the Catalog tree.

To add directories for data, click on the Connect to folder icon on the top left toolbar.

Previewing data

A list of files will be displayed with various extensions.

To be able to view file extensions

· Navigate to Customize
· Select Arc Catalog options
· Under the General tab unclick Hide file extension and hit Ok.

Description tab

It provides an explanation of the files, spatial information, and a list of all of the attributes associated with a file.

Properties of Geographic Information Systems (GIS)

· Location
· Attributes
· Spatial relationship

a. Location: Coordinates are used to give the exact location of an object.

b. Attributes: It provides information about the location.

c. Spatial relationship: These are properties associating an object with other objects.

9.4. Navigation tools

9.4.1. The basic tool bar

· Zoom In / Out
· Fixed zoom In / Out
· Zoom to full extent
· Zoom to previous / Next
· Pan

· Zoom In / Out

· Zoom In: Click + and then click anywhere on the map to be enlarged.
· Zoom Out: Click – and then click anywhere on the map to be reduced.

· Fixed zoom In / Out

· Fixed zoom In: It enlarges the image from the center of the page.
· Fixed zoom Out: It reduces the image from the center of the page.

· Zoom to full extent: It zooms the image of the map to its full limit.

· Zoom to previous / Next: It takes the image back to the previous extent after navigating.

“And” key of the keyboard can be used for those operations.

· Pan: Is to move an image horizontally or vertically from a stationary point in order to view from different angles.

9.4.2. Query methods

Find tool: Is a navigation tool used to search for locations using address or name of a place to find features that match particular attribute values and to find locations using linear referencing.

Find features

To find Kigali from the map of Rwanda 

· Click on the Find tool on the Tools bar.
· Click an entry in the results list to flash it the map.

Find locations

To find location

· Click the Find tool to open the Find dialog box and click the Locations tab.
· Identify the Locator to be used.
· Enter the Place name or Address to be searched.
· Click on Find button to search for and work with the results.

Linear referencing

Linear referencing: Is the method of storing geographic locations by using relative positions along measured linear features.

Query using identify tool

To use the Identify tool, follow the following steps:

· Click the Identify tool on the Tools toolbar.
· Click on a location in the data frame to identify the features at the location.
· Alternately, one can create a box to identify a group of features. Click on a features within the selected box appears.

Feature geometry is needed to use:

· Flash 
· Zoom to
· Pan to
· Create book mark

Choosing the layers to identify

The Identify tool identifies the top most layer in your map by default. Use the Identify from list at the top of the identify window to choose the specific layer(s) to identify.

The options can be used:

· Top most layer
· Visible layers
· Selectable layers
· All layers
· A layer

Layers in a Map

A layer: It represents geographic data in a map.

Ordering layers

To change the drawing order:

· Click the table of contents list by drawing order button.
· Click and hold a layer name, then drag it up or down in the table of contents to a new position.

Removing a layer

To remove a layer:

· Right click on the layer to be remove.
· Select the Remove option

Renaming a layer

To rename a given layer:

· Right click on the layer name.
· Select Properties
· In Layers name box, type the new name.
· Click Apply, then Ok.
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